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Copyright
Copyright © 2005 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided “as is„. Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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For your safety

QUALIFIED SERVICE
Only qualified personnel may install or repair phone equipment.

ACCESSORIES AND BATTERIES
Use only approved accessories and batteries. Do not connect incompatible products.

CONNECTING TO OTHER DEVICES
When connecting to any other device, read its user’s guide for detailed safety instructions. Do not connect
incompatible products.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Ni-Cd/NiMh batteries, discharge the battery from time to time by leaving the
product switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.

RM-78
Nokia Customer Care Battery information

Page viii COMPANY CONFIDENTIAL Issue 1
Copyright © 2005 Nokia. All rights reserved.

 



Company Policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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 Product selection
Nokia RM-78 is a WCDMA/GSM dual mode phone, supporting WCDMA 2100 (UMTS) and EGSM 900/ 1800/1900
bands.

Figure 1 RM-78 product picture

 Phone features

Display and keypad
• Integrated Flash LED

• Large high resolution QVGA color display (320x240 pixels) with 262k colors 2.2" (33.48mm x 44.64mm)
display

• 2MPix camera with integrated flash and mirror, VGA camera for Video call

• Landscape mode for image capturing

• 6 MB flash for user data and SD Mini card (hot swap)

• 5-way scroll, soft keys, send key, end key and center select

• PoC (Push To Talk) key on the side

• Side volume key with camera zoom functionality

• Dedicated key for camera application

Bearers and transport
• WCDMA 2100 and GSM Tri-band 900/1800/1900

• EDGE release 99: MSC 10 (RX+TX 4+1, 3+2)
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• GPRS: MSC 10 (RX+TX: 4+1, 3+2, class B & C)

• HSCSD, CSD

• Speech codec support for FR, EFR, AMR, WB-AMR

Software platform
• Nokia series 40

Connectivity
• USB through Pop-Port™ connector

• Bluetooth 1.2

• IrDA

• 2 mm charger plug

User Interface
• SMS, MMS

• E-mail client with support for attachment

• WAP 2.0, XHTML browser over HTTP/TCP/IP stack

• Video Call and Video Ringtones

• Video streaming and recording

• Video, MP3, AAC, eAAC+ and 64 poly ringing tones

• Push to Talk

• Visual Radio

• Logs (last calls , timers and history list)

• Java & APIs: MIDP2.0, JSR139 (CLDC1.1), JSR75 (file connection and PIM), JSR135, JSR184 (3D), JSR82 (BT)

• Stereo Music Player supporting MP3, MP4, eAAC+, AAC

• Data Transfer

Sales package
• Transceiver RM-78

• 64 Mbyte mini SD card

• Classic Stereo Headset HS-23

• CA-53 data-cable

• BP-6M Li-Ion 970 mAh Battery

• AC-4 Charger (2 mm plug)

• Booklet - Users manual

• CD-ROM

 Mobile enhancements

Table 1 Audio

Type Description

HDB-4 Boom headset

HDS-3 Stereo headset
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Type Description

HDW-3 Wireless headset

HS-3 Fashion headset

HS-4W Wireless boom headset

HS-5 Mono headset

HS-8 Activity headset

HS-13 Wireless image headset

HS-21W Wireless clip-on headset

HS-23 Classic stereo headset

HS-37W Wireless headset

LPS-4 Loopset

MD-1 Music stand

Table 2 Car

Type Description

BHF-3 Headrest handsfree

CK-1W Wireless car kit

CK-7W Advanced car kit (sales pack) (EURO 1)

CK-10 Car kit

CR-43 Mobile holder

HF-3 Basic handsfree

HF-6W Plug-in car handsfree

Table 3 Data

Type Description

CA-53 Connectivity cable

PC suite

Table 4 Imaging

Type

Description

Description

PT-6 Nokia remote camera

Table 5 Messaging

Type Description

SU-1B Nokia digital pen (Eur/US)
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Table 6 Power

Type Description

AC-3 Compact charger

AC-4 Travel charger

AC-44 Charger adapter

BP-6M Battery Li-on

DC-4 Mobile charger

 Technical specifications

General specifications

Unit Dimension (mm) Weight (g) Volume (cc)

Transceiver with BP-6M
970mAh Li-Ion battery
pack

100x46x21 115 91

Main RF characteristics for triple GSM band and WCDMA band phones (Europe)

Parameter Unit

Cellular system GSM/EGSM900,GSM1800/1900

WCDMA2100

Rx frequency band EGSM900: 925 - 935 MHz

GSM900: 935 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

WCDMA: 2110- 2170 MHz

Tx frequency band EGSM900: 880 - 890 MHz

GSM900: 890 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

WCDMA: 1920 - 1980 MHz

Output power GSM900: +5 … +32.5 dBm

GSM1800: +0 … +30 dBm

GSM1900: +0 ... +30 dBm

WCDMA2100: 0 ...+24 dBm
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Parameter Unit

Number of RF channels GSM900: 125

GSM1800: 375

GSM1900: 300

WCDMA2100: 8

Channel spacing GSM 200 KHz

WCDMA 4.8 MHz

Number of Tx power levels GSM900: 15

GSM1800: 16

GSM1900: 16

WCDMA2100: 12

Battery endurance

Nokia measurements of operation times

Talk time

Battery: BP-6M 970mAh In GSM Up to 3 hours in GSM and up to 2.5 hours in
WCDMA

Standby time

Battery: BP-6M 970mAh Up to 250 hours in GSM and 200 in WCDMA

Note: Variation in operation times will occur depending on SIM card, network settings and usage.
Talk time is increased by up to 30% if half rate is active and reduced by 5% if enhanced full rate is
active.

Environmental conditions

Environmental
condition

Ambient temperature Notes

Normal operation 15 oC ... +55 oC Specifications fulfilled

Reduced performance 55 oC ... +70 oC Operational only for short periods

Intermittent or no
operation

-40 oC ... -15 oC and +70 oC ... +85oC Operation not guaranteed but an
attempt to operate will not damage
the phone

No operation or
storage

<-40 oC and >+85 oC No storage. An attempt to operate
may cause permanent damage

Charging allowed -15 oC ... +55 oC

Long term storage
conditions

0 oC ... +85 oC
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Environmental
condition

Ambient temperature Notes

Humidity and water
resistance

Relative humidity range is 5 to 95%.

Condensed or dripping water may
cause intermittent malfunctions.

Protection against dripping water
has to be implemented in (enclosure)
mechanics.

Continuous dampness will cause
permanent damage to the module.
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 Exploded view

Figure 2 Exploded view
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 Mechanical parts list

Table 7 Mechanical parts list

ITEM/CIRCUIT REF. QTY PART NAME

* = not available as spare part

1 A-cover assembly

I001* 1 A-cover

I002* 1 Powerkey

I003 1 UI Keymat

I004 1 Display metal shield

1 UI PWB assembly

I005* 1 Domesheet

I006* 1 UI PWB

I007 1 LCD module

I008 1 VGA camera

1 Camera guide assembly

I009* 1 Camera guide

I010* 1 Earpiece adhesive

I011* 1 Earpiece

1 Main flex assembly

I101* 1 Camera socket

I102* 1 Spring detection magnet

I103* 3 Connector

I104* 1 Main flex

I105* 1 Power switch

1 C-cover assembly

I106 1 UI PWB adhesive

I107* 1 Power key adhesive

I108* 1 C-cover upper part

I109* 1 Spring

I110* 1 Slide mechanics

I111* 1 C-cover fixed lower part

I112* 1 Backplate sticker

1 Keymat assembly
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ITEM/CIRCUIT REF. QTY PART NAME

I201* 1 Keymat

I202* 1 Main keymat adhesive

1 Light SWAP engine module assembly

I203 1 Main domesheet

I204* 1 Engine module

I205 1 Type label

I206 1 RF shielding lid

I207 1 BB shielding lid

I208 1 WCDMA shielding lid

I209 1 SMIA camera

1 D-cover assembly

I210* 1 POC key

I211* 1 Volume key

I212* 1 Camera key

I213* 1 SD lid

I214* 1 IRDA window

I215 1 DC-jack

I216 1 Microphone

I217* 1 D-cover

I218* 1 LED flash light

I219* 1 SIM lid

I220 1 IHF label

I221 1 IHF lid including Pogopins

I222 1 IHF speaker

I223 1 IHF gasket

I224* 1 Antenna

I225* 1 BT Antenna

I226 4 Screws T6+

I227 1 B-cover

RM-78
Parts and layouts Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 2 –7
Copyright © 2005 Nokia. All rights reserved.

 



 Spare parts overview

Figure 3 Spare parts overview
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 SWAP phones

Table 8 SWAP phones for RM-78

SWAP phones for RM-78

N6280 RM-78 SWAP ENGINE C.BLACK E&A

N6280 RM-78 SWAP ENGINE C.BLACK SA

N6280 RM-78 SWAP ENGINE C.BLACK FR

N6280 RM-78 SWAP ENGINE C.BLACK TR

N6280 RM-78 SWAP ENGINE C.BLACK RU

N6280 RM-78 SWAP ENGINE C.BLACK UA

N6280 RM-78 SWAP ENGINE C.BLACK HE

N6280 RM-78 SWAP ENGINE C.BLACK AR

N6280 RM-78 SWAP ENGINE C.BLACK GR

N6280 RM-78 SWAP ENGINE G.GREY E&A

N6280 RM-78 SWAP ENGINE G.GREY SA

N6280 RM-78 SWAP ENGINE G.GREY FR

N6280 RM-78 SWAP ENGINE G.GREY TR

N6280 RM-78 SWAP ENGINE G.GREY RU

N6280 RM-78 SWAP ENGINE G.GREY UA

N6280 RM-78 SWAP ENGINE G.GREY HE

N6280 RM-78 SWAP ENGINE G.GREY AR

N6280 RM-78 SWAP ENGINE G.GREY GR

 Component parts list

Table 9 Component parts list (Build 1mda_05a)

Item Name PWB
Side

XY. Value

B2200 CRYSTAL 32.768KHZ +/-30PPM 12.5PF
T J6

32.768K
Hz -

C1000 CHIPCAP X5R 1U K 6V3 0603 T N8 1u 6V3

C1001 CHIPCAP X5R 100N K 10V 0402 T N8 100n 10V

C1008 CHIPCAP X5R 1U K 6V3 0603 T M5 1u 6V3

C1009 CHIPCAP NP0 27P J 50V 0402 T O8 27p 50V

C1010 CHIPCAP NP0 27P J 50V 0402 T O8 27p 50V

C1060 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T N8 2x1u 6V3

C2000 CHIPCAP NP0 27P J 50V 0402 B A3 27p 50V
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Item Name PWB
Side

XY. Value

C2001 CHIPCAP X5R 1U K 25V 0603 B B2 1u 25V

C2002 CHIPCAP X7R 1N0 K 50V 0402 B B5 1n0 50V

C2003 CHIPCAP FEEDTHRU 100N M 25V 0805 B B2 100n 25V

C2004 CHIPCAP X5R 4U7 K 6.3V 0603 B B4 4u7 6V3

C2005 CHIPCAP X7R 33N K 10V 0402 B A4 33n 10V

C2007 CHIPCAP X7R 10N K 16V 0402 B A7 10 16V

C2008 CHIPCAP X7R 10N K 16V 0402 B A7 10 16V

C2009 CHIPCAP X7R 10N K 16V 0402 B A6 10 16V

C2010 CHIPCAP X7R 10N K 16V 0402 B A6 10 16V

C2011 CHIPCAP NP0 10P J 50V 0402 B B7 10p 50V

C2012 CHIPCAP NP0 10P J 50V 0402 B B7 10p 50V

C2013 CHIPCAP NP0 10P J 50V 0402 B B6 10p 50V

C2014 CHIPCAP NP0 10P J 50V 0402 B B6 10p 50V

C2015 CHIPCAP NP0 270P J 50V 0402 B A3 270p 50V

C2016 CHIPCAP X7R 33N K 10V 0402 B A4 33n 10V

C2070 CHIPCAP NP0 27P J 50V 0402 T M6 27p 50V

C2071 CHIPCAP NP0 27P J 50V 0402 T E6 27p 50V

C2100 CHIPCAP X7R 33N K 10V 0402 T I6 33n 10V

C2101 CHIPCAP X7R 33N K 10V 0402 T H6 33n 10V

C2102 CHIPCAP X5R 4U7 K 6.3V 0603 T I6 4u7 6V3

C2105 CHIPCAP X7R 1N0 K 50V 0402 T I8 1n0 50V

C2106 CHIPCAP X7R 1N0 K 50V 0402 T I8 1n0 50V

C2107 CHIPCAP X7R 1N0 K 50V 0402 T I8 1n0 50V

C2108 CHIPCAP X7R 1N0 K 50V 0402 T C6 1n0 50V

C2109 CHIPCAP X7R 1N0 K 50V 0402 T I8 1n0 50V

C2110 CHIPCAP X7R 1N0 K 50V 0402 T I8 1n0 50V

C2200 CHIPCAP X5R 1U K 6V3 0402 T I7 1u 6V3

C2201 CHIPCAP X5R 1U K 6V3 0603 T K6 1u 6V3

C2202 CHIPCAP X7R 1N0 K 50V 0402 T J6 1n0 50V

C2203 CHIPCAP X7R 1N0 K 50V 0402 T J6 1n0 50V

C2204 CHIPCAP X7R 1N0 K 50V 0402 T I6 1n0 50V

C2205 CHIPCAP X7R 1N0 K 50V 0402 T I6 1n0 50V

C2206 CHIPCAP X7R 1N0 K 50V 0402 T I6 1n0 50V

C2207 CHIPCAP X7R 1N0 K 50V 0402 T K6 1n0 50V
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Item Name PWB
Side

XY. Value

C2208 CHIPCAP NP0 27P J 50V 0402 T J6 27p 50V

C2209 CHIPCAP NP0 22P J 50V 0402 T K6 22p 50V

C2210 CHIPCAP X5R 1U K 16V 0603 T K8 1u 16V

C2211 CHIPCAP X5R 4U7 K 10V 0805 T J8 4u7 10V

C2212 CHIPCAP X5R 1U K 6V3 0603 T K7 1u 6V3

C2215 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T K8 2x1u 6V3

C2217 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T K5 2x1u 6V3

C2220 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T J8 2x1u 6V3

C2221 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T J8 2x1u 6V3

C2222 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T K6 2x1u 6V3

C2223 CHIPCAP X7R 10N K 16V 0402 T I7 10 16V

C2224 CHIPCAP X7R 10N K 16V 0402 T I7 10 16V

C2225 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T K8 2x1u 6V3

C2226 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T K8 2x1u 6V3

C2229 CHIPCAP NP0 22P J 50V 0402 T J6 22p 50V

C2230 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T K7 2x1u 6V3

C2231 CHIPCAP X5R 10U M 6V3 0805 T I7 10u 6V3

C2232 CHIPCAP NP0 27P J 50V 0402 T K7 27p 50V

C2233 CHIPCAP NP0 56P J 50V 0402 T K7 56p 50V

C2236 CHIPCAP X7R 1N0 K 50V 0402 T K7 1n0 50V

C2300 CHIPCAP X7R 10N K 16V 0402 T H2 10 16V

C2301 CHIPCAP X5R 22U M 6V3 0805 T H1 22u 6V3

C2302 CHIPCAP X5R 22U M 6V3 0805 T H2 22u 6V3

C2303 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T I5 2x1u 6V3

C2304 CHIPCAP X7R 10N K 16V 0402 T G4 10 16V

C2305 CHIPCAP NP0 27P J 50V 0402 T G4 27p 50V

C2307 CHIP ARRAY X5R 2X1U (2x1U2) K 6V3 0405 T I5 2x1u 6V3

C2309 CHIPCAP X5R 22U M 6V3 0805 T H2 22u 6V3

C2313 CHIPCAP X5R 1U K 6V3 0603 T I4 1u 6V3

C2405 CHIPCAP X5R 1U K 6V3 0603 B J8 1u 6V3

C2406 CHIPCAP X5R 1U K 6V3 0603 B J8 1u 6V3

C2430 CHIPCAP NP0 27P J 50V 0402 B L2 27p 50V

C2500 CHIPCAP X5R 4U7 K 6.3V 0603 T F6 4u7 6V3

C2501 CHIPCAP X5R 100N M 16V 0402 T E6 100n 16V

RM-78
Parts and layouts Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 2 –11
Copyright © 2005 Nokia. All rights reserved.

 



Item Name PWB
Side

XY. Value

C2502 CHIPCAP NP0 27P J 50V 0402 T E6 27p 50V

C2503 CHIPCAP X5R 22U M 6V3 0805 T G7 22u 6V3

C2504 CHIPCAP X5R 1U K 25V 0603 T F6 1u 25V

C2530 CHIPCAP X5R 22U M 6V3 0805 B M8 22u 6V3

C2531 CHIPCAP X5R 22U M 6V3 0805 B M8 22u 6V3

C2532 CHIPCAP X5R 22U M 6V3 0805 B L8 22u 6V3

C2534 CHIPCAP NP0 27P J 50V 0402 T L8 27p 50V

C2535 CHIPCAP X7R 1N0 K 50V 0402 B K8 1n0 50V

C2537 CHIPCAP X5R 22U M 6V3 0805 B M8 22u 6V3

C2600 CHIPCAP X5R 4U7 K 10V 0805 T P1 4u7 10V

C2601 CHIPCAP NP0 22P J 50V 0402 T N1 22p 50V

C2602 CHIPCAP X5R 100N K 10V 0402 T N1 100n 10V

C2603 CHIPCAP X5R 100N K 10V 0402 T O1 100n 10V

C2700 CHIPCAP X5R 100N K 10V 0402 T G6 100n 10V

C2701 CHIPCAP NP0 27P J 50V 0402 T G6 27p 50V

C2702 CHIPCAP NP0 27P J 50V 0402 T G6 27p 50V

C2703 CHIPCAP NP0 27P J 50V 0402 T H6 27p 50V

C2704 CHIPCAP NP0 27P J 50V 0402 T G6 27p 50V

C2800 CHIPCAP X5R 100N K 10V 0402 T L4 100n 10V

C2801 CHIPCAP X5R 100N K 10V 0402 T K1 100n 10V

C2802 CHIPCAP X5R 100N K 10V 0402 T L4 100n 10V

C2803 CHIPCAP X5R 100N K 10V 0402 T K1 100n 10V

C2804 CHIPCAP X5R 100N K 10V 0402 T M1 100n 10V

C2805 CHIPCAP X5R 100N K 10V 0402 T J2 100n 10V

C2806 CHIPCAP X5R 100N K 10V 0402 T J3 100n 10V

C2807 CHIPCAP X5R 1U K 6V3 0603 T J1 1u 6V3

C2808 CHIPCAP X5R 100N K 10V 0402 T L1 100n 10V

C2809 CHIPCAP X5R 100N K 10V 0402 T L1 100n 10V

C2810 CHIPCAP X5R 100N K 10V 0402 T M1 100n 10V

C2811 CHIPCAP X5R 100N K 10V 0402 T M1 100n 10V

C2812 CHIPCAP X5R 100N K 10V 0402 T K4 100n 10V

C2813 CHIPCAP X5R 100N K 10V 0402 T L4 100n 10V

C2814 CHIPCAP X5R 100N K 10V 0402 T J2 100n 10V

C2815 CHIPCAP X7R 10N K 16V 0402 T K1 10 16V
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C2816 CHIPCAP X5R 100N K 10V 0402 T L4 100n 10V

C2819 CHIPCAP NP0 27P J 50V 0402 T M1 27p 50V

C3000 CHIPCAP X5R 100N M 16V 0402 T I4 100n 16V

C3001 CHIPCAP X7R 10N K 16V 0402 T I4 10 16V

C3002 CHIPCAP X5R 220N K 6.3V 0402 T I1 220n 6V3

C3003 CHIPCAP X7R 10N K 16V 0402 T I1 10 16V

C3005 CHIPCAP X7R 10N K 16V 0402 T J4 10 16V

C3006 CHIPCAP X7R 10N K 16V 0402 T J4 10 16V

C3007 CHIPCAP X5R 220N K 6.3V 0402 T J4 220n 6V3

C3008 CHIPCAP X5R 220N K 6.3V 0402 T K4 220n 6V3

C3009 CHIPCAP X7R 10N K 16V 0402 T K4 10 16V

C3100 CHIPCAP NP0 27P J 50V 0402 T L1 27p 50V

C3200 CHIPCAP X5R 100N K 10V 0402 T C7 100n 10V

C3201 CHIPCAP X5R 1U K 6V3 0603 T D7 1u 6V3

C3202 CHIPCAP X7R 10N K 16V 0402 T E7 10 16V

C3203 CHIPCAP X5R 1U K 6V3 0603 T D7 1u 6V3

C3204 CHIPCAP X5R 100N K 10V 0402 T G5 100n 10V

C3310 CHIPCAP NP0 27P J 50V 0402 B J4 27p 50V

C3311 CHIPCAP NP0 27P J 50V 0402 B J4 27p 50V

C3312 CHIPCAP NP0 27P J 50V 0402 B K4 27p 50V

C3313 CHIPCAP NP0 27P J 50V 0402 B K5 27p 50V

C3314 CHIPCAP NP0 27P J 50V 0402 B J5 27p 50V

C3315 CHIPCAP NP0 27P J 50V 0402 B J5 27p 50V

C463 CHIPCAP X5R 220N K 6.3V 0402 T J5 220n 6V3

C466 CHIPCAP X7R 10N K 16V 0402 T J5 10 16V

C6000 CHIPCAP X5R 100N M 16V 0402 B J3 100n 16V

C6001 CHIPCAP X5R 100N M 16V 0402 B K3 100n 16V

C6002 CHIPCAP X5R 1U K 6V3 0603 B I2 1u 6V3

C6003 CHIPCAP X5R 1U K 6V3 0603 B K2 1u 6V3

C6004 CHIPCAP X5R 100N M 16V 0402 B I2 100n 16V

C6005 CHIPCAP X5R 100N M 16V 0402 B K2 100n 16V

C6010 CHIPCAP NP0 4P7 C 50V 0402 B K2 4p7 50V

C6011 CHIPCAP NP0 5P6 C 50V 0402 B K3 5p6 50V

C6050 CHIPCAP X5R 1U K 6V3 0603 B I3 1u 6V3
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C6051 CHIPCAP X5R 1U K 6V3 0603 B J3 1u 6V3

C6052 CHIPCAP NP0 15P J 50V 0402 B I3 15p 50V

C7500 CHIPCAP X5R 4U7 K 6.3V 0603 T P3 4u7 6V3

C7501 CHIPCAP X5R 4U7 K 6.3V 0603 T O4 4u7 6V3

C7502 CHIPCAP X5R 4U7 K 6.3V 0603 T O5 4u7 6V3

C7503 CHIPCAP X5R 4U7 K 6.3V 0603 T P3 4u7 6V3

C7504 CHIPCAP X7R 3N9 J 50V 0402 T N4 3n9 50V

C7505 CHIPCAP X7R 10N K 16V 0402 T N4 10 16V

C7506 CHIPCAP X7R 1N0 J 50V 0402 T O3 1n0 50V

C7507 CHIPCAP X5R 100N M 16V 0402 T Q3 100n 16V

C7508 CHIPCAP NP0 10P J 50V 0402 T N3 10p 50V

C7509 CHIPCAP X5R 100N M 16V 0402 T N3 100n 16V

C7510 CHIPCAP NP0 470P J 6V3 0402 T N4 470p 6V3

C7512 CHIPCAP NP0 2N2 G 16V 0603 T N4 2n2 16V

C7514 CHIPCAP NP0 2P7 C 50V 0402 T Q4 2p7 50V

C7515 CHIPCAP NP0 3P3 C 50V 0402 T Q4 3p3 50V

C7516 CHIPCAP NP0 0P5 C 50V 0402 T N3 0p5 50V

C7521 CHIPCAP X5R 4U7 K 6.3V 0603 T S5 4u7 6V3

C7541 CHIPCAP X5R 4U7 K 6.3V 0603 T S6 4u7 6V3

C7542 CHIPCAP X5R 4U7 K 6.3V 0603 T S6 4u7 6V3

C7543 CHIPCAP X5R 4U7 K 6.3V 0603 T S7 4u7 6V3

C7544 CHIPCAP X7R 22N K 16V 0402 T Q6 22n 16V

C7545 CHIPCAP NP0 10P J 50V 0402 T Q6 10p 50V

C7547 CHIPCAP NP0 1P8 C 50V 0402 T O5 1p8 50V

C7597 CHIPTCAP 150U M 10V 6X3.2X1.5 T N2 150u 10V

C8000 CHIPCAP NP0 HQ 1P5 B 25V 0402 T Q2 1p5 25V

D3000 sdram 8MX16 1.8/1.8v WBGA60 PBFREE T J5 - -

D3001 FLASH 16MX16 1.8/1.8V FBGA44 PBFREE T I2 - -

D6000 BTHFM1.0 ES4 Module B J2 - -

F2000 SM FUSE F 2.0A 32V 0603 B A2 2.0A 32V

G2200 RTC BACKUP CAPAC 311 SIZE FOR 2.6V 4UAH T E8 - -

G7500 VCTCXO 38.4 MHZ 2.5V
T N5 38.4 MHz

2.5
V

G7501 VCO 3296-3980MHZ 4-BAND Matsushita
T N3

3296-39
80MHz -
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L1000 FERRITE BEAD 0.6R 600R/100MZ 0402
T N8

600R/
100Mhz -

L1001 FERRITE BEAD 0.6R 600R/100MZ 0402
T M5

600R/
100Mhz -

L2002 CHIP BEAD ARRAY 2X1000R 0405
B A5

2x1000R
/100MHz -

L2003 CHIP BEAD ARRAY 2X1000R 0405
B B6

2x1000R
/100MHz -

L2004 CHIP BEAD ARRAY 2X1000R 0405
B B7

2x1000R
/100MHz -

L2006 CHIP COIL 68NH J Q12/100MHZ 0603
B A6

68n/
100Mhz 0

L2100 CHIP BEAD ARRAY 2X1000R 0405
B B5

2x1000R
/100MHz -

L2101 FERR.BEAD 220R/100M 2A 0R05 0603
T I8

220R/
100Mhz -

L2102 CHIP COIL 30nH J Q65/500MHz 0805 T P2 30n -

L2103 CHIP COIL 30nH J Q65/500MHz 0805 T P2 30n -

L2104 FERR.BEAD 220R/100M 2A 0R05 0603
T I8

220R/
100Mhz -

L2105 FERR.BEAD 220R/100M 2A 0R05 0603
T I8

220R/
100Mhz -

L2108 FERR.BEAD 220R/100M 2A 0R05 0603
T I8

220R/
100Mhz -

L2202 FERR.BEAD 220R/100M 2A 0R05 0603
T K8

220R/
100Mhz -

L2203 FERRITE BEAD 0.6R 600R/100MZ 0402
T K7

600R/
100Mhz -

L2204 FERRITE BEAD 0.6R 600R/100MZ 0402
T K7

600R/
100Mhz -

L2205 FERR.BEAD 220R/100M 2A 0R05 0603
T I8

220R/
100Mhz -

L2206 FERRITE BEAD 0.6R 600R/100MZ 0402
T K6

600R/
100Mhz -

L2233 FERR.BEAD 240R/100M 0.4A 0R4 0402
T K7

240R/
100MHz -

L2301 FERR.BEAD 220R/100M 2A 0R05 0603
T H2

220R/
100Mhz -

L2302 INDUCT WW 10U 0A65 0R35 4X4X1.2 T H3 10u -
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L2303 FERR.BEAD 0R03 42R/100MHZ 3A 0805

T I5

42R/
1000MH

z -

L2304 FERRITE BEAD 0.6R 600R/100MZ 0402
T I5

600R/
100Mhz -

L2400 FERRITE BEAD 0.6R 600R/100MZ 0402
B J8

600R/
100Mhz -

L2401 FERRITE BEAD 0.6R 600R/100MZ 0402
B J8

600R/
100Mhz -

L2500

FERR.BEAD 0R03 42R/100MHZ 3A 0805

T F6

42R/
1000MH

z -

L2530 CHOKE 4U7 0.86A 0R17 3X3X1.5 T L7 4u7 -

L2702 CHIP COIL 39N J Q24/800MHZ 0402 T H6 39n -

L2703 CHIP COIL 39N J Q24/800MHZ 0402 T H6 39n -

L2704 CHIP COIL 39N J Q24/800MHZ 0402 T H6 39n -

L3200
FERRITE BEAD 0.6R 600R/100MZ 0402

T D7
600R/

100Mhz -

L7500 FERRITE BEAD 0.6R 600R/100MZ 0402
T O3

600R/
100Mhz -

L7520 FERRITE BEAD 0R01 28R/100MHZ 0603
T S5

28R/
100MHz -

L7540 CHOKE 3U3 1.2A 0R15 3X3X1.5 T S7 3u3 -

L7541 CHIP COIL 22N J Q28/800MHZ 0402 T Q8 22n -

L7543 CHIP COIL 3N3 +-0N3 Q28/800M 0402 T P5 3n3 -

L8000 INDUCT WW 3N6 C 25/6000 0603
T R2

3n6/250
MHz -

M2100 SMD VIBRA MOTOR 1.3V 90MA 9000RPM T B7 - -

N1060 VREG 2.85/150MA(LP3987-2.85)USMD5 T O8 - -

N2430 HALL IC SWITCH SH248CSP VCC B M2 - -

N2500 BUCK/BOOST CONV. REG710NA-5 SOT23-6 T F6 - -

N2530 DC/DC BOOST CONV. TPS61058 QFN-10 T L8 - -

N2600 IRDA 1.15Mbps 2.2mm RoHS T N1 - -

N3200 VREG & LEVELSHIFT(LP3928)USMD16 T D7 - -

N6050 VREG 2.85/150MA(LP3987-2.85)USMD5 B I3 - -

N7500 RF SYSTEM MODULE PIHI2.22 9.0 x 9.0 x 1 T P4 - -

N7520 PA RF9282E6.2 GSM/EDGE 850/900/1800/1900 T S4 - -

N7540 PA MODULE RF9372E5,2 WCDMA 1850-1980MHz T R6 - -
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N7541 DC CONV SAMURAI LM3202TL NOPB revB µSMD8 T S6 - -

R1000 CHIPRES 0W06 100R J 0402 T J3 100R -

R1001 CHIPRES 0W06 100R J 0402 T J3 100R -

R2000 ASIP MIC W/ESD RES+CAP+ZDI BGA11 B A4 - -

R2001 CHIPRES 0W06 10K J 0402 B A5 10K -

R2002 CHIPRES 0W06 220R J 0402 B B4 220R -

R2003 VAR.ARRAY 2X16V 824-915MHZ 0405 B A5 - -

R2004 CHIPRES 0W06 33K J 0402 B A4 33K -

R2005 CHIPRES 0W06 10R J 0402 B A6 10R -

R2006 CHIPRES 0W06 10R J 0402 B A6 10R -

R2007 CHIPRES 0W06 10R J 0402 B A7 10R -

R2008 CHIPRES 0W06 10R J 0402 B A7 10R -

R2009 VAR.ARRAY 2X16V 824-915MHZ 0405 B A6 - -

R2010 VAR.ARRAY 2X16V 824-915MHZ 0405 B A7 - -

R2011 ASIP SILIC USB OTG / ESD BGA11 B B3 - -

R2012 RES NETWORK 0W06 220K/120K J 0404
B A4

220K/
120K -

R2013 CHIPRES 0W06 100R J 0402 B A3 100R -

R2015 CHIPRES 0W06 10R J 0402 B B4 10R -

R2016 CHIP VARISTOR VWM14V VC50V 0402 B B3 - 50V

R2019 CHIPRES JUMPER 0R0 0402 T C7 0R0 -

R2020 CHIPRES 0W06 2K2 J 0402 T D7 2K2 -

R2021 CHIPRES 0W06 1M0 J 0402 T D7 1M0 -

R2070 NTC RES 0W1 47K J B 4050+-3% 0402 T E6 47K -

R2100 ASIP MIC W/ESD RES+CAP+ZDI BGA11 T I6 - -

R2101 CHIPRES 0W06 220R J 0402 T I6 220R -

R2102 CHIPRES 0W06 33K J 0402 T I7 33K -

R2103 VAR.ARRAY 2X16V 824-915MHZ 0405 B B5 - -

R2104 RES NETWORK 0W06 2X10R J 0404 T I7 2x10R -

R2106 VAR.ARRAY 2X16V 824-915MHZ 0405 T P2 - -

R2200 CHIPRES 0W06 100K J 0402 T J6 100K -

R2201 CHIPRES 0W06 120K J 0402 T K6 120K -

R2202 CHIPRES 0W06 4K7 J 0402 T K6 4K7 -

R2203 CHIPRES 0W06 2M2 J 0402 T J6 2M2 -
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R2204 CHIPRES 0W06 4K7 J 0402 T J6 4K7 -

R2205 CHIPRES 0W06 220R J 0402 T I6 220R -

R2206 CHIPRES 0W06 470R J 0402 T I7 470R -

R2400 CHIPRES 0W06 100K J 0402 B I4 100K -

R2430 CHIPRES 0W06 470K J 0402 B M2 470K -

R2500 CHIPRES 0W06 10K J 0402 T F7 10K -

R2502 CHIPRES 0W06 10K J 0402 T E7 10K -

R2531 CHIPRES 0W06 39K J 0402 B K8 39K 0

R2534 CHIPRES 0W06 10K J 0402 B K8 10K -

R2537 CHIPRES 0W06 56K J 0402 B K8 56K -

R2538 RES METFI 0W2 F 0603 B L8 0R75 -

R2539 CHIPRES 0W06 150K J 0402 B K8 150K -

R2540 RES METFI 0W2 F 0603 B L8 0R75 -

R2581 CHIPRES 0W06 150R J 0603 B I4 150R -

R2582 CHIPRES 0W06 150R J 0603 B I6 150R -

R2600 CHIPRES 0W125 4R7 J 0805 T P1 4R7 -

R2700 ASIP SIM INTERFACE **low cap** BGA8 T G6 - -

R2800 CHIPRES 0W06 100K J 0402 T K1 100K -

R2802 CHIPRES JUMPER 0R0 0402 T J1 0R0 -

R3000 CHIPRES 0W06 4K7 J 0402 T I4 4K7 -

R3004 CHIPRES JUMPER 0R0 0603 T J4 0R0 -

R3005 CHIPRES JUMPER 0R0 0603 T J1 0R0 -

R3006 CHIPRES JUMPER 0R0 0603 T K5 0R0 -

R3007 CHIPRES JUMPER 0R0 0603 T K5 0R0 -

R3200 ASIP MMC FILTER *** PB-FREE *** T D7 - -

R3203 CHIPRES JUMPER 0R0 0402 T G5 0R0 -

R3204 CHIPRES 0W06 1K2 J 0402 T D6 1K2 -

R3204 CHIPRES 0W06 1K2 J 0402 T D6 1K2 -

R3205 CHIPRES 0W06 680R J 0402 T D6 680R -

R3205 CHIPRES 0W06 680R J 0402 T D6 680R -

R3210 CHIPRES JUMPER 0R0 0603 T E7 0R0 -

R3211 CHIPRES JUMPER 0R0 0603 T E7 0R0 -

R3212 CHIPRES JUMPER 0R0 0603 T D7 0R0 -

R3301 VAR.ARRAY 2X16V 824-915MHZ 0405 B I8 - -
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R3302 CHIPRES JUMPER 0R0 0402 B I8 0R0 -

R3303 CHIPRES JUMPER 0R0 0402 B I8 0R0 -

R3541 CHIPRES 0W06 22K J 0402 B K8 22K -

R6000 CHIPRES JUMPER 0R0 0402 B I2 0R0 -

R6010 CHIPRES 0W06 10K J 0402 B J3 10K -

R6011 CHIPRES 0W06 8K2 J 0402 B J3 8K2 -

R6015 CHIPRES JUMPER 0R0 0402 T B4 0R0 -

R6050 CHIPRES JUMPER 0R0 0603 B I2 0R0 -

R6051 CHIPRES JUMPER 0R0 0603 B K2 0R0 -

R6052 CHIPRES JUMPER 0R0 0603 B I3 0R0 -

R6053 CHIPRES JUMPER 0R0 0603 B I2 0R0 -

R7500 CHIPRES 0W06 22K J 0402 T N4 22K -

R7501 CHIPRES 0W06 4K7 J 0402 T Q3 4K7 -

R7503 CHIPRES 0W06 1K0 F 200PPM 0402 T N4 1K0 -

R7504 CHIPRES 0W06 8K2 F 0402 T N4 8K2 -

R7505 CHIPRES 0W06 5R6 J 0402 T O3 5R6 -

R7520 CHIPRES 0W06 27K F 0402 T R5 27K -

R7521 CHIPRES JUMPER 0R0 0402 T R3 0R0 -

R7522 CHIPRES JUMPER 0R0 0402 T R5 0R0 -

R7540 CHIPRES 0W06 47K F 200PPM 0402 T R7 47K -

R7541 CHIPRES 0W06 1K0 F 200PPM 0402 T S6 1K0 -

R7542 CHIPRES JUMPER 0R0 0402 T Q6 0R0 -

R7543 CHIPRES 0W06 22K J 0402 T Q6 22K -

R7544 CHIPRES 0W06 10R J 0402 T R7 10R -

R7570 CHIPRES JUMPER 0R0 0402 T S6 0R0 -

R7571 CHIPRES 0W06 4K7 F 200PPM 0402 T S6 4K7 -

R8000 CHIPRES JUMPER 0R0 0603 T Q2 0R0 -

S2583 SM SW TACT SPST 12V SIDE KEY 2.2N T C8 - -

S2587 SM SW TACT SPST 12V SIDE KEY 2.2N T Q1 - -

S2591 SM SW TACT SPST 12V SIDE KEY 2.2N T Q9 - -

S2595 SM SW TACT SPST 12V SIDE KEY 2.2N T N9 - -

T7500 TRANSF BALUN 2134 +/- 30MHZ 0805 T Q3 - -

T7501 TRANSF BALUN 3800 +/- 550MHZ 0805 T O4 - -

V2000 TVS DI 1PMT16AT3 16V 175W PWRMITE B B3 - -
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V2002 TR 2SC5658QRS N 50V 0A1 0W15 VMT3 T C7 - -

V2500 TR 2SC5658QRS N 50V 0A1 0W15 VMT3 T F7 - -

V2581 LED WHITE 100MCD 20MA 0DEG B H4 - -

V2582 LED WHITE 100MCD 20MA 0DEG B H6 - -

X1000 SM CAMERA MOD SKT 2X8F T O6 - -

X2000 SM SYSTEM CONNECTOR 14POL T A5 - -

X2061 MODULE ID COMPONENT 2.8X1.8X0.3 B L2 - -

X2070 SM BATTERY CONN 3POL SPR 12V 2A T M6 - -

X2530 C-SPRING ANTENNA T M8 - -

X2531 C-SPRING ANTENNA T M8 - -

X2700 SM SIM CONN 6POL P2.54 H1.8 T F8 - -

X3200 CONN MINISD PUSH - PUSH 10V 0.5A T E3 - -

X8000 SM CONN RF JACK 50R 2W 6GHZ T Q2 - -

X8001 C-SPRING ANTENNA ( active ) T S2 - -

X8002 C-SPRING ANTENNA T S2 - -

X8003 SM CONN RF JACK 50R 2W 6GHZ T O8 - -

X8004 C-SPRING ANTENNA ( active ) T R8 - -

X8005 C-SPRING ANTENNA T R8 - -

X8006 C-SPRING ANTENNA T S1 - -

Z2000 FERRITE BEAD 0.6R 600R/100MZ 0402
B A4

600R/
100Mhz -

Z2001 FERRITE BEAD 0.6R 600R/100MZ 0402
B B4

600R/
100Mhz -

Z2005 FERRITE BEAD 0.6R 600R/100MZ 0402
B B4

600R/
100Mhz -

Z2403 ASIP 10-CH ESD EMI FILTER BGA25 B I4 - -

Z2404 ASIP 10-CH ESD EMI FILTER BGA25 B I5 - -

Z2580 ASIP 10-CH ESD EMI FILTER BGA25 B I7 - -

Z3300 ASIP 10-CH ESD EMI FILTER BGA25 B I6 - -

Z7500 TX SAW MODULE GSM 850/900MHz T Q5 - -

Z7540 DUPL BAW 1920-1980/2110-2170MHZ 3.8x3.8 T Q7 - -

 Component layouts
Note: See also lager size layouts in the Schematics section (page 10–9).
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Component layout, bottom

Figure 4 Component layout, RM-78, 1mda_05a, bottom

Component layout, top

Figure 5 Component layout, RM-78, 1mda_05a top
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 Phoenix installation steps in brief

Before you begin
Recommended hardware requirements:

• Computer processor: Pentium 700 MHz or higher

• RAM 256 MB

• Disk space 100-300 MB

Supported operating systems:

• Windows 2000 Service Pack 3 or higher

• Windows XP Service Pack 1 or higher

Context
Phoenix is a service software for reprogramming, testing and tuning phones.

Phoenix installation contains:

• Service software support for all phone models included in the package

• Flash update package files for programming devices

• All needed drivers for:

• DK2 dongle

• DKU-2 USB cable

Note: Separate installation packages for flash update files and drivers are also available, but it is
not necessary to use them unless there are updates between Phoenix service software releases. If
separate update packages are used, they should be used after Phoenix and data packages have been
installed.

The phone model specific data package includes all changing product specific data:

• Product software binary files

• Files for type label printing

• Validation file for the faultlog repair data reporting system

• All product specific configuration files for Phoenix software components

Note: Phoenix and phone data packages should only be used as complete installation packages.
Uninstallation should be made from the Windows Control Panel.

To use Phoenix, you need to:

Steps
1. Connect a DK2 dongle to the computer parallel port.

2. Install Phoenix.

3. Install the phone-specific data package.

4. Configure users.

5. Manage connection settings (depends on the tools you are using).

If you use FPS-8: • Update FPS-8 software

• Activate FPS-8
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If you use FPS-10: • Update FPS-10 software

Note: There is no need to activate
FPS-10.

• Activate SX-4 smart card, if you need tuning and
testing functions.

Note: When FPS-10 is used only for
product software updates, SX-4 smart
card is not needed.

Results
Phoenix is ready to be used with FPS-8 or FPS-10 flash prommers and other service tools.

 Installing Phoenix

Before you begin
• Check that a dongle is attached to the parallel port of your computer.

• Download the Phoenix installation package (for example, phoenix_service_sw_2004_39_x_xx.exe) to your
computer (in C:\TEMP, for instance).

• Close all other programs.

• Depending on your operating system, administrator rights may be required to install Phoenix.

• If uninstalling or rebooting is needed at any point, you will be prompted by the InstallShield program.

Context
At some point during the installation procedure, you may get the following message:

Figure 6 Dongle not found

This may be a result of a defective or too old PKD-1 dongle.

Check the COM/parallel ports used. After correcting the problem, you can restart the installation.

For more detailed information, please refer to Phoenix Help files.

Tip: Each feature in Phoenix has its own Help function, which can be activated while running the
program. Press the F1 key or the feature’s Help button to activate a Help file.

Steps
1. To start the installation, run the application file (for example,phoenix_service_sw_2004_39_x_xx.exe).

2. In the Welcome dialogue, click Next.
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3. Read the disclaimer text carefully and click Yes.

Figure 7 Disclaimer text

4. Choose the destination folder.

The default folder C:\ProgramFiles\Nokia\Phoenix is recommended.

5. To continue, click Next.

To choose another location, click Browse (not recommended).

6. Wait for the components to be copied.

The progress of the installation is shown in the Setup Status window.

7. Wait for the drivers to be installed and updated.

The process may take several minutes to complete.

If the operating system does not require rebooting, the PC components are registered right away.

If the operating system requires restarting your computer, the Install Shield Wizard will notifies about it.

Select Yes... to reboot the PC immediately or No... to reboot the PC manually afterwards.

After the reboot, all components are registered.

Note: Phoenix does not work, if the components have not been registered.
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8. To end the installation, click Finish.

Figure 8 InstallShield Wizard Complete

Next action
After the installation, Phoenix can be used after:

• installing phone model specific data package for Phoenix
• configuring users and connections

FPS-8 and FPS-10 flash prommers can be used after updating their flash update package files.

 Updating Phoenix installation

Context
• If you already have the Phoenix service software installed on your computer, you need to update the

software when new versions are released.

• To update Phoenix, you need to follow the same steps as when installing it for the first time.

• When you are updating, for example, from version a14_2004_16_4_47 to a15_2004_24_7_55, the update
will take place automatically without uninstallation.

• Always use the latest available versions of both Phoenix and the phone-specific data package. Instructions
can be found in the phone model specific Technical Bulletins and phone data package readme.txt files
(shown during installation).

• If you try to update Phoenix with the same version you already have (for example, a15_2004_24_7_55
to a15_2004_24_7_55), you are asked if you want to uninstall the existing version. In this case you can
choose between a total uninstallation or a repair installation in a similar way when choosing to uninstall
the application from the Windows Control Panel.

• If you try to install an older version (for example, downgrade from a15_2004_24_7_55 to
a14_2004_16_4_47), installation will be interrupted.
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Figure 9 Installation interrupted

• Always follow the instructions on the screen.

Steps
1. Download the installation package to your computer hard disk.

2. Close all other programs.

3. Run the application file (for example, phoenix_service_sw_2004_39_x_xx.exe).

Results
A new Phoenix version is installed and driver versions are checked and updated.

 Uninstalling Phoenix

Context
You can uninstall Phoenix service software manually from the Windows Control Panel.

Steps
1. Open the Windows Control Panel, and choose Add/Remove Programs.
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2. To uninstall Phoenix, choose Phoenix Service Software→Change/Remove→Remove .

Figure 10 Remove program

The progress of the uninstallation is shown.
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3. If the operating system does not require rebooting, click Finish to complete.

Figure 11 Finish uninstallation

If the operating system requires rebooting, InstallShield Wizard will notify you. Select Yes... to reboot the
PC immediately and No... to reboot the PC manually afterwards.

 Repairing Phoenix installation

Context
If you experience any problems with the service software or suspect that files have been lost, use the repair
function before completely reinstalling Phoenix.

Note: The original installation package (for example, phoenix_service_sw_a15_2004_24_7_55.exe)
must be found on your PC when you run the repair setup.

Steps
1. Open Windows Control Panel→Add/Remove Programs .

2. Choose Phoenix Service Software→Change/Remove .
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3. In the following view, select Repair.

Figure 12 Repair program

Phoenix reinstalls components and registers them.

The procedure is the same as when updating Phoenix.

4. To complete the repair, click Finish.

 Phone data package overview
Each product has its own data package (DP). The product data package contains all product-specific data files
to make the Phoenix service software and tools usable with a certain phone model.

The phone data package contains the following:

• Product software binary files

• Files for type label printing

• Validation file for the fault log repair data reporting system

• All product-specific configuration files for Phoenix software components

Data files are stored in C:\Program Files\Nokia\Phoenix (default).

 Installing phone data package

Before you begin
• A phone-specific data package contains all data required for the Phoenix service software and service tools

to be used with a certain phone model.

• Check that a dongle is attached to the parallel port of your computer.

• Install Phoenix service software.
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• Download the installation package (for example, XX-XX_dp_EA_v_1_0.exe) to your computer (for example,
in C:\TEMP).

• Close all other programs.

(XX-XX = type designator of the product)

If you already have Phoenix installed on your computer, you will need to update it when a new version is
released.

Note: Often Phoenix and the phone-specific data package come in pairs, meaning that a certain
version of Phoenix can only be used with a certain version of a data package. Always use the latest
available versions of both. Instructions can be found in phone-specific Technical Bulletins and
readme.txt files of data packages.

Steps
1. To start the installation, run the application file (for example, XX-XX_dp_EA_ v_1_0.exe),

Wait for the installation files to be extracted.

2. Click Next.
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3. In the following view you can see the contents of the data package. Read the text carefully. There is
information about the Phoenix version required with this data package.

Figure 13 Data package setup information

4. To continue, click Next.
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5. Choose the destination folder, and click Next to continue.

Figure 14 Data package destination folder

The InstallShield Wizard checks where Phoenix is installed, and the directory is shown.

6. To start copying the files, click Next.
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Phone model specific files are installed. Please wait.

7. To complete the installation, click Finish.

Figure 15 InstallShield Wizard Complete

Next action
Phoenix can be used for flashing phones and printing type labels after:

• Configuring users

• Managing connections

FPS-8 and FPS-10 can be used after updating their flash update package files.

 Uninstalling phone data package

Context
There is no need to uninstall an older version of a data package, unless instructions to do so are given in
the readme.txt file of the data package and bulletins related to the release.

Please read all related documents carefully.

Steps
1. Locate the data package installation file (e.g. XX-XX_dp_EA_v_1_0.exe) from your computer.

2. To start the uninstallation procedure, double-click the data package installation file.
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3. To uninstall the data package, click OK or to interrupt the uninstallation, click Cancel.

Figure 16 Uninstalling phone data package

4. When the data package is uninstalled, click Finish.

Figure 17 Finishing data package uninstallation

Alternative steps
• You can also uninstall the data package manually from

Control Panel→Add/Remove Programs→xx-xx* Phone Data Package . (*= type designator of the
phone).
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 Configuring users in Phoenix

Steps
1. Start Phoenix service software, and log in.

Figure 18 Phoenix login

If the user ID is already configured, select s/he from the User name drop-down list, and click OK.

2. To add a new user, or to edit existing ones, click Maintain.

3. To add a new user, click New.

4. Type in the name and initials of the user, and click OK.

The user is added to the user name list.

5. Select the desired user from the User name drop-down list, and click OK.

Figure 19 New user configured

 Managing connections in Phoenix

Context
With the Manage Connections feature you can edit and delete existing connections or create new ones.

Note: After choosing the desired connection, and connecting the phone to a PC for the first time,
allow the PC to install the USB device drivers first. Please note that this may take some time to
complete.

If there are problems after the driver installation, check that the USB connection is active from
the Windows Control Panel. If the problem persists, contact the local PC support.

Steps
1. Start Phoenix, and log in.

2. Choose File→Manage Connections... .
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3. To add a new connection, click Add.

4. Select Manual mode, and click Next to continue.

If you want to create the connection using the Connection Wizard, connect the tools and a phone to your
PC. The wizard will automatically try to configure the correct connection.

Figure 20 Select mode: Manual

i For an FPS-10 flash prommer with a USB Connection, choose the following connection settings:

• Media: FPS-10 USB

• DEVICE_INDEX: 0

• SERIAL_NUM: See Serial No from the label attached to the bottom of FPS-10

• ACTIVE_MEDIA: USB

ii For an FPS-10 flash prommer with a LAN connection, choose the following connection settings:

• Media: FPS-10 TCP/IP

• NET_SERV_NAME: Click Scan.... Choose your own FPS-10 device based on the correct MAC address.
See Serial No from the label attached to the bottom of your FPS-10.

• PORT_NUM: Use the default value, and click Next.

• PROTOCOL_FAMILY: Use the default value, and click Next.

• SOCKET TYPE: Use the default value, and click Next.

• TX_BUFFER_SIZE: Use the default value, and click Next.

• RX_BUFFER_SIZE: Use the default value, and click Next.

iii For an FPS-8 flash prommer, choose the following connection settings:

• Media: FPS-8

• PORT_NUM: COM Port where FPS-8 is connected

• COMBOX_DEF_MEDIA: FBUS
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iv For a plain USB connection, choose the following connection settings:

Note: First connect the DKU-2 USB cable between the PC USB port and phone.

• Media: USB

5. To complete the configuration, click Finish.

6. Click the connection you want to activate. Use the up/down arrows located on the right hand side to move
it on top of the list, then click Apply.

Figure 21 Connections list

The connection is activated, and it can be used after closing the Manage Connection window.

The connection information is shown at the right hand bottom corner of the screen.

Figure 22 Connection information

7. To use the connection, connect the phone to your PC with correct service tools. Make sure the phone is
switched on, and then choose File→Scan Product .

Results
The product support module information appears in the status bar:

Figure 23 Product support module information (example from RM-1)

 Installing flash support files for FPS-8 and FPS-10

Before you begin
• Install Phoenix service software.

• Install phone model specific data package for Phoenix.

• If you want to update the flash support files, they are delivered in the same installation package with
Phoenix or newer Phoenix packages beginning from December 2004.

In case you want to update the MCU files, install the latest data package (see Technical Bulletins for
information on the latest one).

Normally, it is enough to install Phoenix and the phone-specific data package because the installation
always includes the latest flash update package files for FPS-8 and FPS-10.

• A separate installation package for flash support files is available. The files can be updated according to
these instructions, if updates appear between Phoenix data package releases.
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Context
If you are not using a separate installation package, you can skip this section and continue with  “Updating
FPS-8 and FPS-10 flash prommer software„ (page 3–23) after installing a new phone data package.

Steps
1. To begin the installation, double-click the flash update file (for example,

flash_update_03_183_0014.exe).

Figure 24 Flash update welcome dialog

If the same version of the flash update package already exists, and you want to reinstall it, the previous
package is first uninstalled.

Restart installation again after the uninstallation.

2. If you try to downgrade the existing version to older ones, the setup will be aborted. If there is a need to
downgrade the version, uninstall newer files manually from the Windows Control Panel, and then rerun
the installation.

Figure 25 Flash installation interrupted
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If an older version exists on your PC and it needs to be updated, click Next to continue installation.

3. It is recommended to install the files to the default destination folder C:\Program Files\Nokia\Phoenix.
To continue, click Next.

Figure 26 Flash destination folder

When installing the flash update files for the first time, you may choose another location by selecting
Browse (not recommended).
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4. To complete the installation procedure, click Finish .

Figure 27 Finish flash update

Next action
FPS-8 and FPS-10 flash prommers must be updated using Phoenix.

 Updating FPS-8 and FPS-10 flash prommer software

Steps
1. Start Phoenix service software, and log in.

2. Choose the correct connection for your flash prommer: File→Manage Connections...

3. Choose Flashing→Prommer maintenance .
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4. To update the FPS-8/FPS-10 software, click Update, and select the appropriate file fps8upd.ini (for FPS-8)
or fpsxupd.ini (for FPS-10) from C:\Program Files\Nokia\Phoenix\Flash.

Figure 28 Flash directory window

Tip: All files can be loaded separately to the prommer used. To do this, click the right mouse
button in the Flash Box Files pane and select the file type(s) to be loaded.

5. Click OK.

Figure 29 Prommer software update finished
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6. To close the Prommer Maintenance window, click Close.

Figure 30 Prommer Maintenance window

 Activating FPS-8

Context
Before FPS-8 can be successfully used for phone programming, it must first be activated.

First fill in the FPS-8 activation request sheet in the FPS-8 sales package, and follow the instructions given.

When activation file is received (for example, 00000.in), copy it to the C:\ProgramFiles\Nokia\Phoenix
\BoxActivation directory on your computer (this directory is created when Phoenix is installed).

Steps
1. Start Phoenix service software.

2. Choose Flashing→Prommer Maintenance .

3. In the Prommer Maintenance window, click Activate.

4. To find the activation file, click Browse.

RM-78
Service Software Instructions Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 3 –25
Copyright © 2005 Nokia. All rights reserved.

 



5. To activate the prommer, select the activation file and click Open.

Figure 31 Box activation

6. To complete the activation, restart FPS-8.

 Deactivating FPS-8

Context
If there is, for example, a need to send the FPS-8 box for repair, it must be deactivated first.

Steps
1. Start Phoenix service software.

2. Choose Flashing→Prommer Maintenance .

3. In the Prommer Maintenance window, click Deactivate.

4. To confirm the deactivation, click Yes.

Figure 32 Deactivation warning

The box is deactivated.

5. To complete the deactivation, restart FPS-8.
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 Service tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-78, refer to various concepts.

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-10 or FPS-11 to a PC. It is
included in the FPS-10 and FPS-11 sales packages.

CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-10 flash
prommer to the Point-Of-Sales (POS) flash adapter.

CA-53 USB connectivity
cable

USB to Pop-PortTM connector cable.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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FLS-4S Flash device

FLS-4S is a dongle and flash device incorporated into one package,
developed specifically for POS use.

FPS-10 Flash prommer

FPS-10 interfaces with:

• PC

• Control unit

• Flash adapter

• Smart card

FPS-10 flash prommer features:

• Flash functionality for BB5 and DCT-4 terminals

• Smart Card reader for SX-2 or SX-4

• USB traffic forwarding

• USB to FBUS/Flashbus conversion

• LAN to FBUS/Flashbus and USB conversion

• Vusb output switchable by PC command

FPS-10 sales package includes:

• FPS-10 prommer

• Power Supply with 5 country specific cords

• USB cable

FS-6 Flash adapter

• FS-6 is equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using coupler

• multiplexing between USB and FBUS media, controlled by VUSB

RM-78
Service Tools and Service Concepts Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 4 –7
Copyright © 2005 Nokia. All rights reserved.

 



JBT-9 Bluetooth test and
interface box (sales
package)

The JBT-9 test box is a generic service device used to perform
Bluetooth bit error rate (BER) testing, and establishing cordless FBUS
connection via Bluetooth. An ACP-8x charger is needed for BER testing
and an AXS-4 cable in case of cordless interface usage testing .

Sales package includes:

• JBT-9 test box

• Installation and warranty information

MJ-76 Module jig

MJ-76 is meant for component level troubleshooting.

The jig includes an RF interface for GSM, WCDMA and Bluetooth. In
addition, it has the following features:

• Provides mechanical interface with the engine module

• Provides galvanic connection to all needed test pads in module

• Multiplexing between USB and FBUS media, controlled by Vusb

• MMC interface

• Duplicated SIM connector

• Connector for control unit

• Access for Pop-PortTM system connector

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled operating voltage.

PKD-1 SW security device

SW security device is a piece of hardware enabling the use of the
service software when connected to the parallel (LPT) port of the PC.

Without the device, it is not possible to use the service software.

Printer or any such device can be connected to the PC through the
device if needed.
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RF shield box

Because the WCDMA network disturbs the RX side testing of the WCDMA
phone and the Tx signal of the WCDMA phone can severely disturb the
WCDMA network, a shield box is needed in all testing, tuning and fault
finding which requires WCDMA RF signal.

The shield box is not an active device, it contains only passive filtering
components for RF attenuation.

RJ-104 BTHFM rework jig

RJ-104 is a rework jig used when servicing the BTHFM module. It is
used together with rework stencil ST-37.

RJ-114 Rework jig

RJ-114 is a rework jig used with ST-41.

RJ-56 Rework jig

RJ-56 is a rework jig used with ST-21.

RJ-73 Rework jig

RJ-73 is a rework jig used with ST-42.
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RJ-88 Soldering jig

RJ-88 is a soldering jig used for soldering and as a rework jig for the
engine module.

SA-92 RF coupler

SA-92 is an RF coupler for WCDMA and GSM RF testing. It is used
together with the product-specific flash adapter.

The following table shows attenuations from the antenna pads of the
mobile terminal to the SMA connectors of SA-92:

• Frequency Att. (dB)

GSM900 TX 2,7 dB +/- 0,5 dB

GSM900 RX 2,6 dB +/- 0,7 dB

GSM1800 TX 8,2 dB +/- 2,0 dB

GSM1800 RX 5,3 dB +/- 0,4 dB

GSM1900 TX 5,1 dB +/- 0,1dB

GSM1900 RX 5,2 dB +/- 0,6 dB

WCDMA2100 TX 10,0 dB +/- 0,9dB

WCDMA2100 RX 6,8 dB +/- 0,4 dB

SPS-1 Soldering Paste
Spreader

SRT-6 Opening tool
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SS-45 Front camera
removal tool

The front camera removal tool SS-45 is used to remove/attach the
front camera module from/to the socket.

SS-46 Interface adapter

SS-46 acts as an interface adapter between a product-specific flash
adapter and FPS-10.

SS-51 Front camera
removal tool

The front camera removal tool SS-51 is used to remove/attach a front
camera module from/to the camera socket of the phone PWB.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

ST-21 Rework stencil

ST-21 is a rework stencil used with rework jig RJ-56.
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ST-22 Rework stencil

ST-22 is a rework stencil used with rework jig RJ-57.

ST-37 BTHFM rework stencil

ST-37 stencil is used with RJ-104 BTHFM rework jig.

ST-41 Rework stencil

ST-41 is a rework stencil used with rework jig RJ-114.

ST-42 Rework stencil

ST-42 is a rework stencil used with rework jig RJ-73.

ST-44 Rework stencil

ST-44 is a rework stencil used with rework jig RJ-57.
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SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-10 when DCT-4 phones are
flashed.

XCS-4 Modular cable

XCS-4 is a shielded (one specially shielded conductor) modular cable
for flashing and service purposes.

XRF-1 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector ca. 610mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WLAN: 0.6+-0.1dB
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 Service concepts

Flash concept with FPS-10

Figure 33 Basic flash concept with FPS-10

Note: FPS-8 concept can also be used for flashing.

Item Type Description

1 FS-6 Flash adapter

2 SS-46 Interface adapter

3 CA-35S Power cable

4 XCS-4 Modular cable

5 FPS-10 Flash prommer box

6 Standard USB cable

7 PKD-1 SW security device
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MJ-76 module jig concept

Legend
Module jig concept is meant for BB / RF testing + tuning and for flashing purposes.

Figure 34 MJ-76 module jig service concept

Item Type Description

1 MJ-76 Module jig

2 CU-4 Control unit

3 FPS-10 Flash prommer box

4 SX-4 Smart card

5 XCS-4 Modular cable

6 PCS-1 DC power cable

7 Standard USB cable

8 Standard USB cable

9 GPIB control cable

10 XRS-6 RF cable

11 PKD-1 SW security device
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Item Type Description

12 RF shield box

Note: Item 12 not shown in the picture.

POS (Point of Sale) flash concept

Figure 35 POS flash concept

Item Type Description

1 CA-53 USB connectivity cable

2 FLS-4S POS flash device
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RF testing and BB testing

Figure 36 RF testing and BB testing

Item Type Description

1 SS-62

FS-6

Flash adapter base

Flash adapter

2 CU-4 Control unit

3 SA-92 RF coupler

4 PCS-1 Power cable

5 Standard USB cable

6 Standard USB cable + smart card reader

7 SX-4 Smart card

8 GPIB control cable

9 XRS-6 RF cable

10 PKD-1 SW security device

11 RF shield box

Note: Item 11 is not shown in the figure.
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CU-4 flash concept with FPS-10

Figure 37 CU-4 flash concept with FPS-10

Note: FPS-8 concept can also be used for flashing.

Item Type Description

1 SS-62

FS-6

Flash adapter base

Flash adapter

2 CU-4 Control unit

3 XCS-4 Modular cable

4 PCS-1 Power cable

5 FPS-10 Flash prommer box

6 Standard USB cable

7 Standard USB cable

8 PKD-1 SW security device
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Service concept for RF/BB testing and tuning

Figure 38 Service concept for RF/BB testing and tuning

Item Type Description

1 MJ-76 Module jig

2 CU-4 Control unit

3 Standard USB cable

4 PCS-1 DC power cable

5 Standard USB cable + smart card reader

6 SX-4 Smart card

7 XRS-6 RF cable

8 GPIB control cable

9 PKD-1 SW security device

10 RF shield box

Note: Item 10 not shown in the picture.
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LAN connection flash concept

Figure 39 LAN connection flash concept

Item Type Description

1 SS-62

FS-6

Flash adapter base

Flash adapter

2 SS-46 Interface adapter

3 CA-35S Power cable

4 XCS-4 Modular cable

5 FPS-10 Flash prommer box

6 LAN cable

7 LAN cable

8 PKD-1 SW security device
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 Disassembly instructions (Upper part)

Steps
1. You need the following tools.

2. Protect the window with a plastic film

3. Protect the camera window with a plastic film.

4. Release the B-cover.
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5. Remove the Battery cover. Ensure that no battery is inserted before you continue.

6. Shift out the unit. Release the clips of the top side first.

7. Slide along on both sides of the A-cover to release all clips.

8. Lift up the A-cover.
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9. Protect the innerside window with a plastic film. Remove the keymat as shown.

10. Protect the LCD with a plastic film.

11. Shift together the unit. Lift up the glued UI PWB assy carefully with the SRT-6.

12. Lift the UI PWB together with the LCD module.
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13. Carefully release the flex connector at one side first.

14. Now release the other side of the flex connector..

15. Take away the UI PWB assy.

16. Release the connector of the LCD module carefully while fixing the flex foil. Remove the LCD module now.
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17. Separate the LCD module from the Display metal shield.

18. Release the Camera guide assy with the SRT-6.

19. Release the VGA camera with the SS-51. Fix the Main flex near the camera socket while removing the
camera.

20. For assembly: mind the correct positioning of the VGA camera.
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21. Shift the unit into mid position. Release the connector of the main flex assy.

22. Slot the flex connector through the C-cover assy carefully.

23. Lift the glued Power switch carefully.

 Reassembly instructions (Upper part)

Steps
1. For reassembly, follow the Disassembly instructions, but in reversed order

Note: Pay special attention to step 20.

Note: For reassembly, ALWAYS USE NEW SCREWS.
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 Disassembly instructions (Lower part)

Steps
1. Open the B-cover by pressing it from the bottom side.

2. Ensure that no battery is inserted.

3. Unscrew all screws in the shown order.

Note: For assembly use the reverse order and a torque of 25 Ncm.

4. Once removed, the screws can't be used again.

Note: Always use new screws for assembly!
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5. Release the clips of the D-cover.

6. Remove the D-cover.

7. Remove the SMIA CAmera with the SS-45.
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8. Mind the correct position for assembly.

9. Lift up the Engine module, but remember that the flex connector is still connected.

10. Open the flex connector carefully

11. Lever out the glued Keymat assy.

12. Ensure that no residue of adhesive remains.

Note: Always use new adhesive for assembly.
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13. Remove the DC jack with the DC plug.

14. Release the IHF label with the SRT-6.

15. Remove the IHF lid.

16. Peel up the IHF label completely. Make sure that no residue remains.

Note: Always use a new IHF label for reassembly.
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17. Lever out the IHF speaker.

18. Always remove the residues of the IHF gasket.

Note: Use a new IHF gasket for reassembly.

19. Ease out the microphone with a dental tool. Once removed, the microphone cannot be used again.

 Reassembly instructions (Lower part)

Steps
1. For reassembly, follow the Disassembly instructions, but in reversed order

Note: Pay special attention to steps 18, 16, 12, 8, 4 and 3.

Note: For reassembly, ALWAYS USE NEW SCREWS.
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 General troubleshooting
For practical reasons troubleshooting is divided in three different chapters:

• Baseband troubleshooting
• Camera troubleshooting
• RF troubleshooting including FM Radio and Bluetouth

Figure 40 Main troubleshooting tree
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 Dead or jammed device troubleshooting

Troubleshooting flow
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 General power checking

Voltages
Check the following voltages:

Signal
Rename

Regulator Sleep Idle Nominal
voltage

Main user Notes

VIO RETU ON ON 1.82 Memory, I/Os,
IrDA, Display

VBACK RETU ON ON 2.5 Back-up
battery

VSIM1 RETU ON ON 1.8/3.0 SIM card

VSIM2 RETU OFF OFF 3.0 Backlight

VDRAM RETU ON ON 1.82 SDRAM

VAUX RETU OFF OFF 2.5 IrDA IrDA active

VANA RETU ON ON 2.5 Audio, some
pull-ups

VR1 RETU OFF ON 2.5 Crystal
oscillators

VRFC RETU OFF ON 1.8 RAP3G
converters

VRCP1 RETU 4.5 To RF parts RF active

VRCP2 RETU 4.5 To RF parts RF active

VREF RETU ON ON 1.4 RF reference

VCORE TAHVO ON ON 1.4 RAP3G digital

VOUT TAHVO OFF OFF 2.5 Accessory
connected

VCAM_2V8 LP3987ITLX-2.
85/N1060

OFF OFF 2.85 Camera Camera ON

VCAM_1V8 LP3985IBLX-1.
8/N1080

OFF OFF 1.8 Camera Camera ON

VCAM_1V5 TPS62311YZD
R/N1050

OFF OFF 1.5 Camera Camera ON

2V8_FM_LCD LP3985ITLX-2.
85/N6050

ON ON 2.85 FM, LCD, Hall
sensor

Camera ON

VMMC LP3928TLX-18
28/N3200

OFF OFF 3.0 MCC card

KEYB_LED_OUT
PUT

REG710NA-5/
N2500

OFF OFF 8 Keyboard LED's
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 Golden eye troubleshooting

Context
Golden eye is placed on the top key board under a non removable shield. Instead of changing the golden
eye, the key board has to be swapped.
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 Charging troubleshooting

Troubleshooting flow
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 Flash programming fault troubleshooting

Troubleshooting flow
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Figure 41 Flashing pic 1. Take single trig measurement for the rise of the BSI signal.
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Figure 42 Flashing pic 2. Take single trig measurement for the rise of the BSI signal.
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 SD card troubleshooting

Troubleshooting flow
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Legend
Take singe trig measurement on the rising edge of the DAT signal.

Figure 43 SD card initialization from pin J3206

 CMT SDRAM memory troubleshooting

Troubleshooting flow
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 CMT NOR flash fault troubleshooting

Troubleshooting flow

Figure 44 CMT NOR flash troubleshooting

Figure 45 NOR CLK from J3004
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 Power key troubleshooting

Troubleshooting flow
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 USB interface troubleshooting

Troubleshooting flow
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Figure 46 USB 1: D-TXD (PopPort TM™ pin 6) and D+RXD (PopPort TM™ pin 7) voltage levels when USB
is connected.
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 SIM card troubleshooting

Troubleshooting flow

RM-78
Nokia Customer Care BB Troubleshooting and Manual Tuning Guide

Page 6 –20 COMPANY CONFIDENTIAL Issue 1
Copyright © 2005 Nokia. All rights reserved.

 



Legend
SIM CLK frequency = 3.2MHz (Take single triggered measurement in boot on the VSIM1 line).

Figure 47 SIM interface signals

 Main keyboard troubleshooting

Context
There are two possible failure modes in the keyboard module:

• One or more keys can be stuck, so that the key does not react when a keydome is pressed. This kind of
failure is caused by mechanical reasons (dirt, rust).

• Malfunction of several keys at the same time; this happens when one or more rows or columns are failing
(shortcut or open connection).

If the failure mode is not clear, start with the Keyboard Test in Phoenix.
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Troubleshooting flow

 Top keyboard troubleshooting

Context
There are two possible failure modes in the keyboard module:

• One or more keys can be stuck, so that the key does not react when a keydome is pressed. This kind of
failure is caused by mechanical reasons (dirt, rust).

• Malfunction of several keys at the same time; this happens when one or more rows or columns are failing
(shortcut or open connection).

If the failure mode is not clear, start with the Keyboard Test in Phoenix.
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Troubleshooting flow

 Slide switch

Context
The slide switch function is based on a hall detector (N2430).

Steps
1. Disassembly the phone and check the hall detector area. Also check the magnet (placed on the flex).

2. Move a magnet over the hall detector and measure on R2430. The scope will indicate a temporary change
in the output (typically 1,8mV).

3. Check supply voltage 2V8_FM_LCD.
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Examples

Figure 48 Slide switch and test point

 Certificate restoring for BB5.0 products

Context
After replacing a defective flash memory component in BB5.0 products, certificate restoring must be carried
out to make the phone functional again.

Certificate restoring for BB5.0 products is basically the same process as IMEI / ESN Rebuild for DCT-4 generation
products.

All tunings (RF & Baseband, UI) must be done after replacing the flash memory component, and performing
the certificate restoring procedure.

The procedure for certificate restoring when a defective flash memory component has been replaced:

• Flash the phone with the latest available software using FPS-8 or FPS-10.

Note: USB flashing does not work for a dead BB5.0 phone.

• Create a request file.

• Send the file to Nokia by e-mail.

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2004.39.7.70 or newer.

• The latest phone model specific Phoenix data package.
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• PKD-1 dongle

• SX-4 smart card (Enables BB5.0 testing and tuning features)

• External smart card reader

Note: The smart card reader is only needed when FPS-8 is used. FPS-10 has an integrated smart
card reader.

• Activated FPS-8 flash prommer OR FPS-10 flash prommer

• Flash update package 03.18.004 or newer for FPS-8 or FPS-10 flash prommers

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-8 or FPS-10.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.

iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to Flashing→SW Update  and wait until Phoenix reads the product data as shown in the following
picture.
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Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next action
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.
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 Display module troubleshooting

General instructions for display troubleshooting

Context
• The display is in a normal mode when the phone is in active use.

• Display is in a partial idle mode when the phone is in the screen saver mode.

• The operating modes of the display can be controlled with the help of Phoenix.

Table 10 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing. If a part of the image is
missing, change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone. Backlight is also
controlled automatically by the ambient light
sensor.

This means that in case the display is working
(image OK), the backlight is faulty.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 11 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect
counts

R G B White Dot
Total

1 1

1 1 1 1

2 Combined
defect
counts

Not allowed.

Two single dot defects that are within 5 mm of each other should be interpreted
as combined dot defect.
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Steps
1. Verify with a working display that the fault is not on the display module itself.

The display module cannot be repaired.

2. Check that the cellular engine is working normally.

i To check the functionality, connect the phone to a docking station.

ii StartPhoenix service software.

iii Read the phone information to check that also the application engine is functioning normally (you
should be able to read the APE ID).

3. Proceed to the display troubleshooting flowcharts.

Use the Display Test tool in Phoenix to find the detailed fault mode.
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Display fault troubleshooting

Troubleshooting flow
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See also
• Display and keyboard backlight troubleshooting (page )
• OMAP1710 troubleshooting (page )

Display and top keyboard backlight troubleshooting

Context
The device has one LED driver that provides current for both display and keyboard backlights.

Troubleshooting flow

Main keyboard backlight troubleshooting

Context
The device has one LED driver that provides current for the main keyboard backlights.
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Troubleshooting flow

 Audio troubleshooting

Audio troubleshooting test instructions
Differential external earpiece and internal earpiece outputs can be measured either with a single-ended or
a differential probe.

When measuring with a single-ended probe each output is measured against the ground.

Internal handsfree output is measured using a current probe, if a special low-pass filter designed for
measuring a digital amplifier is not available. Note also that when using a current probe, the input signal
frequency must be set to 2kHz.

The input signal for each loop test can be either single-ended or differential.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope
• Function generator (sine waveform)
• Current probe (Internal handsfree DPMA output measurement)
• Phoenix service software
• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths can be
activated:
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• External microphone to Internal earpiece

• External microphone to Internal handsfree speaker

• Internal microphone to External earpiece

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test.
Loop path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test
are presented in the following table.

Phoenix audio loop tests and test results
The results presented in the table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.

Loop test Input terminal Output
terminal

Path
gain
[dB]
(fixed)

Input
voltag
e
[mVp-
p]

Differen
tial
output
voltage
[mVp-p]

Outpu
t DC
level
[V]

Outp
ut
curre
nt
[mA]

External Mic to External
Earpiece

XMICP and GND HSEAR R P,
HSEAR R N
and GND

-2.9 1000 720 1.2 NA

HSEAR P,
HSEAR N and
GND

XMICN and GND HSEAR R P,
HSEAR R N
and GND

HSEAR P,
HSEAR N and
GND

External Mic to Internal
Earpiece

XMICP and GND EarP and GND -4.5 1000 600 1.2 NA

EarN and
GND

XMICN and GND EarP and GND

EarN and
GND

External Mic to Internal
handsfree

XMICP and GND B2102 pads -5 1000 560 0 25m
A
(calc
.)

XMICN and GND B2102 pads
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Loop test Input terminal Output
terminal

Path
gain
[dB]
(fixed)

Input
voltag
e
[mVp-
p]

Differen
tial
output
voltage
[mVp-p]

Outpu
t DC
level
[V]

Outp
ut
curre
nt
[mA]

Internal Mic to External
Earpiece

B2100 (OUT/
GND)

HSEAR R P,
HSEAR R N
and GND

22.7 100 1360 1.2 NA

HSEAR P,
HSEAR N and
GND

HSEAR R P,
HSEAR R N
and GND

HSEAR P,
HSEAR N and
GND

Measurement data

Figure 49 Single-ended output waveform of the Ext_in_HP_out measurement when earpiece is
connected.
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Legend
If a special low-pass filter designed for measuring digital amplifiers is unavailable, the measurement must
be performed with a current probe and the input signal frequency must be 2kHz.

Figure 50 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker
is connected.

Figure 51 Single-ended output waveform of the HP_in_Ext_out loop when microphone is connected.
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Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow

RM-78
BB Troubleshooting and Manual Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 6 –39
Copyright © 2005 Nokia. All rights reserved.

 



IHF troubleshooting

Troubleshooting flow
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External microphone troubleshooting

Troubleshooting flow
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External earpiece troubleshooting

Troubleshooting flow
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Vibra troubleshooting

Troubleshooting flow

 Baseband manual tuning guide

Energy management calibration

Before you begin
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.
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• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product. .

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 12 Calibration value limits

Parameter Min. Max.

ADC Offset -20 20

ADC Gain 12000 14000

BSI Gain 1100 1300

VBAT Offset 2400 2650

VBAT Gain 19000 23000

VCHAR Gain N/A N/A

IBAT (ICal) Gain 7750 12250

9. Click Read and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 Introduction to camera module troubleshooting

Background, tools and terminology
Faults or complaints in camera operation can be roughly categorised into three subgroups:

1 Camera is not functional at all; no image can be taken.

2 Images can be taken but there is nothing recognizable in them.

3 Images can be taken and they are recognizable but for some reason the quality of images is seriously
degraded.

Image quality is very hard to measure quantitatively, and even comparative measurements are difficult
(comparing two images) to do, if the difference is small. Especially if the user is not satisfied with his/her
device's image quality, and tells, for example, that the images are not sharp, it is fairly difficult to accurately
test the device and get an exact figure which would tell whether the device is functioning properly.

Often subjective evaluation has to be used for finding out if a certain property of the camera is acceptable
or not. Some training or experience of a correctly operating reference device may be needed in order to
detect what actually is wrong.

It is easy for the user to take bad images in bad conditions. Therefore the camera operation has to be checked
always in constant conditions (lighting, temperature) or by using a second, known-to-be good device as
reference.

When checking for possible errors in camera functionality, knowing what error is suspected significantly
helps the testing by narrowing down the amount of test cases. The following types of image quality problems
may be expected to appear:

• Dust (black spots)

• Lack of sharpness

• Bit errors

Terms

Dynamic range Camera's ability to capture details in dark and bright areas of the scene
simultaneously.

Exposure time Camera modules use silicon sensor to collect light and for forming an
image. The imaging process roughly corresponds to traditional film
photography, in which exposure time means the time during which the
film is exposed to light coming through optics. Increasing the time will
allow for more light hitting the film and thus results in brighter image. The
operation principle is exactly the same with silicon sensor, but the shutter
functionality is handled electronically i.e. there is no mechanical moving
parts like in film cameras.

Flicker Phenomenon, which is caused by pulsating in scene lighting, typically
appearing as wide horizontal stripes in an image.

Noise Variation of response between pixels with same level of input illumination.

Resolution Usually the amount of pixels in the camera sensor; for example, RM-78 has
a 1600 x 1200 pixel sensor resolution. In some occasions the term
resolution is used for describing the sharpness of the images.
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Sensitivity Camera module's sensitivity to light. In equivalent illumination conditions,
a less sensitive camera needs a longer exposure time to gather enough
light in forming a good image. Analogous to ISO speed in photographic
film.

Sharpness Good quality images are 'sharp' or 'crisp', meaning that image details are
well visible in the picture. However, certain issues, such as non-idealities
in optics or high levels of digital zoom, cause image blurring, making
objects in picture to appear 'soft'. Each camera type typically has its own
level of performance.

 The effect of image taking conditions on image quality
There are some factors, which may cause poor image quality, if not taken into account by the end user when
shooting images, and thus may result in complaints. The items listed are normal to camera operation and
are not a reason for changing the camera module.

Distance to target
The lens in the module is specified to operate satisfactorily from 70 cm to infinite distance of scene objects.
In practice, the operation is such that close objects may be noticed to get more blurred when distance to
them is shorter than 70 cm. The lack of sharpness is first visible in full resolution images. If observing just
the viewfinder, even very close objects may seem to appear sharp. This is normal; do not change the camera
module.

Figure 52 Blurred image. Target too close.

The amount of light available
In dim conditions camera runs out of sensitivity. The exposure time is long (especially in the night mode)
and the risk of getting shaken (= blurred) images increases. In addition, image noise level grows. The
maximum exposure time in the night mode is ¼ seconds. Therefore, images need to be taken with extreme
care and by supporting the phone when the amount of light reflected from the target is low. Because of the
longer exposure time and larger gain value, noise level increases in low light conditions. Sometimes blurring
may even occur in daytime, if the image is taken very carelessly. See the figure below for an example. This
is normal; do not change the camera module.
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Figure 53 Blurring caused by shaking hands

Movement in bright light
If an image is taken of moving objects or if the device is used in a moving vehicle, object 'skewing' or 'tilting'
may occur. This phenomenon is fundamental to most CMOS camera types, and usually cannot be avoided.
The movement of camera or object sometimes cause blurring indoors or in dim lighting conditions because
of long exposure time. This is normal; do not change the camera module.

Figure 54 Near objects get skewed when taking images from a moving vehicle
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Temperature
High temperatures inside the mobile phone cause more noise to appear in images. For example, in +70
degrees (Celsius), the noise level may be very high, and it further grows if the conditions are dim. If the phone
processor has been heavily loaded for a long time before taking an image, the phone might have considerably
higher temperature inside than in the surrounding environment. This is also normal to camera operation;
do not change the camera module.

Figure 55 Noisy image taken in +70 degrees Celsius

Phone display
If the display contrast is set too dark, the image quality degrades: the images may be very dark depending
on the setting. If the display contrast is set too bright, image contrast appears bad and "faint". This problem
is solved by setting the display contrast correctly. This is normal behaviour; do not change the camera module.

Basic rules of photography (especially shooting against light)
Because of dynamic range limitations, taking images against bright light might cause either saturated image
or the actual target appear too dark. In practice, this means that when taking an image indoors and having,
for example, a window behind the object, the result is usually poor. This is normal behaviour; do not change
the camera module.

Figure 56 Image taken against light
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Flicker
In some occasions a bright fluorescent light may cause flicker in the viewfinder and captured image. This
phenomenon may also be a result, if images are taken indoors under the mismatch of 50/60 Hz electricity
network frequency. The electricity frequency used is automatically detected by the camera module. In some
very few countries, both 50 and 60 Hz networks are present and thus probability for the phenomenon
increases. Flickering occurs also under high artificial illumination level. This is normal behaviour; do not
change the camera module.

Figure 57 Flicker in an image; object illuminated by strong fluorescent light

Bright light outside of image view
Especially the sun can cause clearly visible lens glare phenomenon and poor contrast in images. This happens
because of undesired reflections inside the camera optics. Generally this kind of reflections are common in
all optical systems. This is normal behaviour; do not change the camera module.

Figure 58 A lens reflection effect caused by sunshine
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Examples of good quality images

Figure 59 Good image taken indoors

Figure 60 Good image taken outdoors

 Camera construction
This section describes the mechanical construction of the camera module for getting a better understanding
of the actual mechanical structure of the module.

Table 13 Camera specifications

Sensor type CMOS Sensor

Photo detectors 1.9 million

F number/Aperture f/3.2

Focal length 4.9mm (35mm equivalent 37mm)

Focus range 70 cm to infinity

Still Image resolutions 1600x1200, 1280x960, 640x480, 320x240,
160x1200
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Still images file format EXIF (JPEG), *.jpg

Video resolutions 640x480, 352x288, 176x144, 128x96. All at 30
frames per second

Video clip length 10 seconds or free, maximal clip length in free mode
is 1 hour (limited by amount of space on external
memory card)

Video file format 3GPP, *.3gp

Exposure Automatic

White Balance Automatic

Colours 16.7 million / 24-bit

Capture Modes Night mode, Sequence mode, self timer

Figure 61 Camera module cross section and assembly principle
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Figure 62 Camera module bottom view including serial numbering

The camera module as a component is not a repairable part, meaning that the components inside the module
may not be changed. Cleaning dust from the front face is allowed only. Use clean compressed air.

The camera module uses socket type connecting. For versioning, laser marked serial numbering is used on
the PWB.

The main parts of the module are:

• Lens unit including lens aperture.

• Infrared filter; used to prevent infrared light from contaminating the image colors. The IR filter is glued
to the EMI shielded camera body.

• Camera body; made of conductive metallized plastic and attached to the PWB with glue.

• Sensor array including DSP functions is glued and wire-bonded to the PWB.

• PWB, FR-4 type

• Passive components

• Camera protection window; part of the phone cover mechanics

• Dust gasket between the lens unit and camera protection window

 Image quality analysis

Testing for dust in camera module

Symptoms and diagnosis
For detecting these kinds of problems, take an image of a uniform white surface and analyse it in full
resolution. A good quality PC monitor is preferred for analysis. Search carefully, since finding these defects
is not always easy. Figure "Effects of dust on optical path" is an example image containing easily detectable
dust problems.
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When taking a white image, use uniformly lightened white paper or white wall. One possibility is to use
uniform light but in this case make sure that the camera image is not flickering when taking the test image.
In case flickering happens, try to reduce illumination level. Use JPEG image format for analysing, and set the
image quality parameter to ‘High Quality’.

Black spots in an image are caused by dirt particles trapped inside the optical system. Clearly visible and
sharp edged black dots in an image are typically dust particles on the image sensor. These spots are searched
for in the manufacturing phase, but it is possible that the camera body cavity contains a particle, which may
move onto the image sensor active surface, for example, when the phone is dropped. Thus it is also possible
that the problem will disappear before the phone is brought to service. The camera should be replaced if the
problem is present when the service technician analyses the phone.

If a dust particle is lying on the infrared filter surface on either side, they are hard to locate because they are
out of focus, and appear in the image as large, grayish and fading-edge 'blobs'. Sometimes they are invisible
to the eye, and thus the user probably does not notice them at all. However, it is possible that a larger particle
disturbs the user, causing need for service.

Figure 63 Effects of dust on optical path

If large dust particles get trapped on top of the lens surface in the cavity between camera window and lens,
they will cause image blurring and poor contrast. The dust gasket between the window and lens should
prevent any particles from getting into the cavity after the manufacturing phase. Dust in this position should
be blown away by using compressed air.
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Unauthorized disassembling of the product can also be the root of the problem. However, in most cases it
should be possible to remove the particle(s) by using clean compressed air. Never wipe the lens surface before
trying compressed air; the possibility of damaging the lens is substantial. Always check the image sharpness
after removing dust.

Testing camera image sharpness

Symptoms and diagnosis
If pictures taken with a device are claimed to be blurry, there are six possible sources for the problem:

1 The protection window is fingerprinted, soiled, dirty, visibly scratched or broken.

2 The photographed object is too close – the camera lens operates with distances from 70 cm to infinity.
This is no cause to replace camera module.

3 User has tried to take pictures in too dark conditions, and images are blurred due to handshake or
movement. This is no cause to replace camera module.

4 There is dirt between the protection window and camera lens.

5 The protection window is defective. This can be either a manufacturing failure or caused by the user. The
window should be changed.

6 The camera lens is misfocused because of a manufacturing error.

7 Very high level of digital zoom is used

A quantitative analysis of sharpness is very difficult to conduct in any other environment than optics
laboratory. Therefore, subjective analysis should be used.

If no visible defects (items 1-4) are found, a couple of test images should be taken. Generally, a well-
illuminated typical indoor scene can be used as a target. The main considerations are:

• The protection window has to be clean.

• The amount of light (300 – 600 lux (bright office lighting)) is sufficient.

• The scene should contain, for example, small objects for checking sharpness. Their distance should be 1
– 2 meters.

• If possible, compare the image to another image of the same scene, taken with a different device. Note
that the reference device has to be a similar Nokia phone.

Steps
1. Take several images of small objects in the distance of 1-2 metres.

2. Analyse the images on a PC screen at 100% scaling with the reference images.

Pay attention to the computer display settings: at least 65000 colors (16-bit) have to be used. True colour
(24-bit, 16 million colours) or 32-bit (full colour) setting is recommended.

Next action
If there appears to be a clearly noticeable difference between the reference image and the test images, the
module might have a misfocused lens -> change the module.

Re-check the resolution after changing the camera module.

If the changed module produces the same result, the fault is probably in the camera window. Check the
window by looking carefully through it when replacing the module.

Dirty camera lens protection window
The following series of images demonstrates the effects of fingerprints on the camera protection window.
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It should be noted that the effects of any dirt in images can vary much. It may be difficult to judge whether
the window has been dirty or if something else is wrong. Therefore, the cleanness of the protection window
should always be checked and the window should be wiped clean with a suitable cloth.

Figure 64 Image taken with clean protection
window

Figure 65 Image taken with greasy protection
window

Image bit errors
Bit errors are image defects caused by data transmission errors between the camera module and the phone
baseband and/or errors inside the module.

Usually bit errors can be easily detected in images, and they are best visible in full resolution images. A good
practice is to use a uniform white test target when analysing these errors. The errors are clearly visible,
colourful sharp dots or lines in camera images. See the following figure.

Figure 66 Bit errors caused by JPEG compression

One type of bit error is a lack of bit depth. In this case, the image is almost totally black under normal
conditions, and only senses something in very highly illuminated environments. Typically this is a contact
problem between the camera module and the phone main PWB. Very black images and viewfinder may also
be caused by failure of the 2.8V supply to the camera. You should check the camera assembly and connector
contacts.

If the fault is in the camera module, bit errors are typically visible only when using some specific image
resolution. For example, in case of a viewfinder fault, the error might exist but is not visible in a full size
image.
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 Camera troubleshooting flowcharts

Back camera troubleshooting

Camera hardware failure message troubleshooting

Context
If you get a hardware failure message when using the camera, follow the next troubleshooting flowchart.

Troubleshooting flow

Note: Make sure that the phone has the latest software before continuing.
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Camera baseband HW troubleshooting

Troubleshooting flow
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Camera viewfinder troubleshooting

Troubleshooting flow
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Bad camera image quality troubleshooting

Troubleshooting flow
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Front camera troubleshooting

Front camera hardware failure message troubleshooting

Troubleshooting flow
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Front camera HW baseband troubleshooting

Troubleshooting flow
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Front camera bad image quality troubleshooting

Troubleshooting flow

 Flash LED troubleshooting

Introduction to flash LED troubleshooting
A fault or complaint associated to LED flash operation can be roughly categorized into two subgroups:

1 Flash is not functional at all (no light output at all).

2 Images can be taken and they are recognizable but for some reason the quality of images is degraded.
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The quality of an image is very difficult to measure quantitatively, and even comparative measurements are
difficult (comparing two images), if the difference between reference images is small. If a user is not satisfied
with his/her device's image quality, it is fairly difficult to accurately test the device and get an exact result,
which would tell if the device is working properly.

Often subjective evaluation has to be used for finding out if there is something wrong in the flash. Some
training or experience of a correctly operating reference device may be needed in order to detect possible
faults. It is easy for a user to take low quality images in bad conditions. Therefore, the camera and flash
operation has to be always checked in constant conditions (lighting, temperature) or by using a second,
known-to-be good reference device.

Flash LED and image taking conditions
This section describes some of common factors, which may cause poor image quality if not taken into account
by end users when taking pictures, and may therefore result in complaints. The items described are normal
to the camera and LED flash operation and do not raise a need for servicing the components.

Figure 67 Example of a good quality image taken with the flash LED

Distance to the target (too close)
There is no feedback in the flash system, which means that the light output is constant in every situation.
This causes the images to overexposure, when shot from close distance. The flash LED is designed to work
optimally between distances of 50cm – 1.20m.

This is normal behaviour; do not change the flash module.
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Figure 68 overexposed image

Distance to the target (too far away):
The power of the white LED flash is still very modest compared to xenon flash technology. Even with the full
power, the maximum distance for an acceptable image quality is roughly 1.2m. If the distance is greater than
1.2m, the images will appear dark and the noise level increases.

This is normal behaviour; do not change the flash module.
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Figure 69 Dark and noisy image

Shaken (= blurred) images
The traditional xenon flash has the advantage of stopping the movement. This is a result of an extremely
short and intense light pulse, which makes it possible for a camera to use very short exposure time. Due to
the weak output of the LED flash, the exposure time has to be actually increased in the viewfinder mode in
total blackness, instead of shortening it. This allows the sensor to integrate longer and collect more light but
this also easily creates blurred images if care is not taken.
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Figure 70 Shaken image

Camera white balance failure and overexposure due to presence of ambient light
Because the spectral output of the flash is known, the white balance and the exposure control of the camera
work in optimal way with the flash in total blackness. This is why some of the pictures may fail, if there is
some ambient light present when the image is taken.

If the flash works correctly in dark conditions, there is no need to change the flash module.
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Figure 71 Camera white balance failure and overexposure

Colour difference between different modules
There is some variation in the spectrum of the flash, which derives from the manufacturing process of the
white LEDs. Because of this variation, there may be some variation in the colour of the images as well.

This is normal behaviour; do not change the flash module.

Figure 72 Color difference between flash colour limit samples
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Analysing image quality

Possible faults in image quality
When checking for possible errors in the flash functionality, knowing what error is suspected, significantly
helps the testing by narrowing down the number of possible test cases. The following types of image quality
problems may be expected to appear:

• LED module is not flashing at all

• Image colours are not good

• Flash power is weak

Testing flash module functionality

Context
With the help of this test you can check the flash module's overall functionality.

Always enable the flash using the "Options" menu before performing the test.

Steps
1. Take an image with the flash and monitor at same time whether the LED module flashes.

Results
If the LED flashes normally, the overall functionality of the module is OK.

Testing image colours with flash

Context
With the help of this test you can check if the image colours are normal when using the flash.

Steps
1. Take an image of a target, which contains something white in total blackness from less than 1 m range.

Results
If the white target appears to be white, the flash is working correctly. However, remember that there is some
variation in the flash colour from module to module.

Testing flash power

Context
With the help of this test you can check if the flash is working with adequate power level.

Steps
1. Take an image with the flash in total blackness (ambient light <1 lux) of a target 80 cm - 1 cm away.

Results
If the flash is working normally with adequate power level, the image is correctly exposed from 80cm – 1m
distances.

Remember that the brightness level in the corners is always less than in the center of the image because of
camera and flash optics.
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Flash LED troubleshooting flowcharts

Flash LED HW baseband troubleshooting

Troubleshooting flow
If there are problems in the flash LED driver circuit, the testing procedure is complicated, because the driver
circuit output cannot be reliably measured without the load (LED). Load (LED) is always disconnected from
the output when the phone is disassembled.
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 General RF troubleshooting

General RF troubleshooting

Most RF semiconductors are static discharge sensitive
Two types of measurements are used in the following. It will be specified if the measurement type is "RF" or
"LF".

• RF measurements are done with a Spectrum Analyzer and a high-frequency 500 ohm passive probe, for
example HP54006A. (Note that when measuring with the 500 ohm probe the signal will be around 20 dB
attenuated. The values in the following will have these 20 dB subtracted and represent the real value seen
on the spectrum analyzer). Note that the testing have some losses which must be taken into consideration
when calibrating the test system.

• LF (Low frequency) and DC measurements should be done with a 10:1 probe and an oscilloscope. The probe
used in the following is 10 Mohm/8pF passive probe. If using another probe then bear in mind that the
voltages displayed may be slightly different. Always make sure the measurement set-up is calibrated when
measuring RF parameters on the antenna pad. Remember to include the loss in the module repair jig when
realigning the phone.

So ESD protection must be applied during repair (ground straps and ESD soldering irons). RF IC N7600 and
FEM are moisture sensitive so parts must be pre-baked prior to soldering. Apart from key-components
described in this document there are a lot of discrete components (resistors, inductors and capacitors) for
which troubleshooting is done by checking if soldering of the component is done properly and checking if
the component is missing from PWB. Capacitors can be checked for short-circuiting and resistors for value
by means of an ohmmeter, but be aware in-circuit measurements should be evaluated carefully. In the
following both the name EGSM and GSM 900 will be used for the lower band and both PCN and GSM 1800 will
be used for the upper band.

 Auto tuning
This phone can be tuned automatically.

Autotune is designed to align the phone's RF part easier and faster. It performs calibrations, tunings and
measurements of RX and TX. The results are displayed and logged in a result file, if initiated.

Hardware set up
Hardware requirements for auto tuning:

• PC (Windows 2000/NT) with GPIB card

• Power supply

• Product specific module jig

• Cables: 3 (alt.1) RF cable, 1 GPIB cable and DAU-9S

• Signal analyser (TX), signal generator (RX) and RF-splitter or one device including all.
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Figure 73 Auto tuning concept with CMU200

Figure 74 Auto tuning concept with RX and TX tuning devices and splitter

Phoenix preparations
Copy the two phone specific ini-files, for example rm_13_tunings.ini and autotune_RM-13.ini, to a phone
specific folder, for example \Phoenix\products\RM-13\.

Auto tuning procedure
1 Make sure the phone (in the jig) is connected to the equipment. Else, some menus will not be shown in

Phoenix.

2 The first time you are using automatic tuning on this phone model, on this computer, you will have to
Set loss for cables and jigs.

3 To go to autotune, select Tuning (Alt-U) > Auto-Tune (Alt-A) from the menu.

4 If you need more assistance, please refer to the Phoenix Help.

 GSM Receivers

GSM RX Troubleshooting

Preparations
Make the following settings:
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Setting GSM900 GSM1800 GSM1900

Phoenix RF Control

Phoenix channel

Continues RX and AGC gain step 14

37 955 661

Signal generator to
antenna connector

942.4677MHz (67.71kHz
offset) at -60dBm

1842.846771MHz
(67.71kHz offset) at
-60dBm

1960.046771MHz
(67.71kHz offset) at
-60dBm

Spectrum analyzer

Centre frequency

RBW=500kHz, VBW=500kHz, span=20kHz

942MHz 1840MHz 1960MHz

Check the following
Check the levels in the steps below.

NO. Signal Name Test point GSM900 GSM1800 GSM1900

1 RXIP (out) J7515 124mVpp,
730mVDC

106mVpp,
760mVDC

100mVpp,
780mVDC

2 RXQP (OUT) J7516 124mVpp,
730mVDC

106mVpp,
690mVDC

100mVpp,
690mVDC

3 VC1_TXFEM J7530 0V 0V 0V

4 VC2_TXFEM J7531 0V 2.7VDC 2.7VDC

5 VC3_TXFEM J7532 0V 0V 2.7VDC

6A* IN_1800 C7515 - -54dBm

(RF level -30dBm)

-

6B* IN_1900 C7514 - - -47dBm

(RF level -30dBm)

*= Note settings in the table above

1 Measure RXIP 1

and RXQP 2.

2 Measure front end module control signal voltages 3, 4 and 5.
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Figure 75 GSM900/1800/1900 RX test points

 GSM Transmitters

GSM900/1800/1900 TX Troubleshooting

Preparations
Make the following settings:

Setting GSM900 GSM1800 GSM1900

Phoenix RF Control

Phoenix Tx Power level

Operational mode = Burst

Tx data type = Random

10 5 5

Check the following
Check the voltages in the steps below.

NO. Signal Name Test point GSM900 GSM1800 GSM1900

1 V_Det_GSM J7533 730mVDC 660mVDC 690mVDC

2 PA_supply-VBAT C7521 3.8VDC 3.8VDC 3.8VDC

3 RF level-ANT_GSM Conn. 23.2dBm 20dBm 20.3dBm

4 Sw cont-VC1_TXFEM J7530 2.75VDC 2.75VDC 2.75VDC
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NO. Signal Name Test point GSM900 GSM1800 GSM1900

5 Sw con-VC2_TXFEM J7531 0V 2.75VDC 2.75VDC

6 Sw con-VC3_TXFEM J7532 2.75VDC 2.75VDC 2.75VDC

7A Tx-1 R7522 397.4MHz/-28.7
dBm

- -

7B Tx-2 R7521 - 1747.8MHz/-24.
6dBm

1880MHz/-25.0
dBm

Figure 76 GSM900/1800/1900 TX test points

 WCDMA Receiver

WCDMA RX Troubleshooting

Preparations
Set Phoenix to RF local mode WCDMA RX.

Equipment/Settinig Unit

Phoenix

WCDMA FDD

RF channel 2140MHz ~10700

Frequency offset +0.000kHz
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Equipment/Settinig Unit

Output channel power -60dBm

P-sch~ -2dB

S-sch~ -2dB

P-cc pch~ -2dB

DPDch~ -7dB

AGCMod* Algorithm

Channel* 10700

BB AGC* 0dB

Spectrum analyzer*

Span ~ 20MHz

Centre frequency 2140MHz

VBW 500kHz

RBW 500kHz

Output channel power -30dB

RF AH ~ 30dB

Check the following
Check the levels in the steps below.

NO. Signal Name Test point Check

1 PXIP (out) J7515 720mVpp single ended

2 RXQP (OUT) J7516 720mVpp single ended

3* WCDMA_RX T7500 Average: -30dBm

-48.3dBm
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Figure 77 WCDMA RX test points

 WCDMA Transmitter

WCDMA TX Troubleshooting

Preparations
Set Phoenix to RF local mode WCDMA TX.

Check the following
Check the levels in the steps below.

NO. Signal Name Test point Check

1 WTXDET C7544 115mVDC

2 VBAT C7542 3.82VDC

3 PA supply - Vreg C7543 2VDC

4 RF level - ANT_WCDMA X8003 0dBm on antenna

5 WCDMA_TX L7543 -34.75dBm at 1450MHz

6 WDET C7545 2.75mVDC

7 DAC101 R7541 828mVDC

DAC201 J7536 2.5VDC
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Figure 78 WCDMA TX test points

 Synthesizer troubleshooting

PIHI (N7500) Troubleshooting

Preparations
Set Phoenix to RF local mode RX burst.

Check the following
Check the voltages in the steps below.

NO. Signal Name Test point Check GSM900

Suppliers

1 VBATRF (in) L7500 3.8VDC

2 VR1_RX (out) C7503 2.8VDC

3 VR1_TX (out) C7502 2.8VDC

4 VR2_TX (out) C7501 2.8VDC

5 VREFRF01 (in)

VB_EXT

R7501 1.36VDC

6 VCP1 (in) C7513 4.76VDC
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Figure 79 PIHI (N7500) test points

Synthesizer Troubleshooting

Preparations
Set Phoenix to RF local mode RX continuous.

Check the following
Check the levels in the steps below.

NO. Signal Name Test point Check

VCTCXO

1 VXO (in) C7504 2.4VDC

2 OSCIN C7500 85mVpp at 38.4MHz

3 AFC (in) R7500 1.2VDC

4 RFCLKEXT (out) C7506 750mVpp at 38.4MHz

VCO

5 VVCO_EXT R7505 2.72VDC

6 VCO Output T7501 -17dBm at 3769.6MHz

7 VCO Control C7510 2.7VDC
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Figure 80 Synthesizer test points
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 Bluetooth and FM radio

Bluetooth troubleshooting

Troubleshooting flow

Figure 81 Troubleshooting diagram: Bluetooth
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FM radio troubleshooting

Troubleshooting flow

Figure 82 Troubleshooting diagram: FM radio
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 Introduction

Block diagram
RAP3G is the main digital baseband ASIC in the phone. It contains functionality for both WCDMA and GSM EDGA
and the Golden Eye is used as a co-processor.

Retu is mainly the audio ASIC in the phone and Tahvo is basically the energy management controller for the
phone.

Bluetooth and stereo FM Radio is integrated in one single ASIC.

Figure 83 Block diagram

 Energy management

Battery and interface
The phone i powered by a 3-pole BP-6M 900 mAh battery. The three poles are named VBAT, BSI and GND
where the BSI line is used to recognize the battery capacity. This is done by means of an internal battery pull
down resistor.
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Figure 84 Battery pin order

Battery temperature is estimated by measuring separate battery temperature NTC via the BTEMP line, which
is located on the main PWB, at a place where the phone temperature is most stabile.

The connection from the charger connector to the charger is established via a charger adaptor type CA-44.

For service purposes, the device SW can be forced into local mode by using pull down resistors connected to
the BSI line.

Normal and extreme voltages
Energy management is mainly carried out in the two Application Specific Integrated Circuits (ASICs) RETU and
TAHVO. These two circuits contains a number of regulators. In addition there are some external regulators
too.

In the table below normal and extreme voltages are shown when a BP-6M battery is used.

Table 14 Nominal voltages

Voltage Voltage [V] Condition

General Conditions

Nominal voltage 3.7 *

Lower extreme voltage 3.145 **

Higher extreme voltage

4.23 ***(fast charging)

HW Shutdown Voltages

Vmstr+ 2.1 ± 0.1 Off to on

Vmstr- 1.9 ± 0.1 On to off

SW Shutdown Voltages

Sw shutdown 3.1 In call

Sw shutdown 3.2 In idle

Min Operating Voltage

Vcoff+ 2.9 ± 0.1 Off to on

Vcoff- 2.6 ± 0.1 On to off

Power key and system power-up
When the battery is placed in the phone the power key circuits are energized. When the power key is pressed,
the system boots up (if an adequate battery voltage is present).

Power down can be initiated by pressing the power key again (the system is powered down with the aid of
SW). The power key is connected to RETU ASIC via PWRONX signal.
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Different power-up conditions
Power up can be caused by the following reasons:

• Power key is pressed

• Charger is connected

• RTC alarm occurs

• MBUS wake-up

After that:

• RETU activates sleep clock and VANA, VDRAM, VIO and VR1 regulators.

• Voltage appearing at RETU’s RSTX pin is used for enabling TAHVO ASIC.

• TAHVO enables VCORE regulator and its internal RC-oscillator (600kHz).

• VCTCXO regulator is set ON and RF clock (main system clock) is started to produce.

• RETU will release PURX ~ 16ms after power up is enabled (the RF clock is then stable enough).

• Synchronizing clock (2.4MHz) for TAHVO is started to be produced. After PURX is released and two rising
edges of 2.4MHz synchronous clock have been detected in SMPSClk input TAHVO is starting to use that
instead of 600kHz internal RC-oscillator.

• HW start-up procedure has been finalized and the system is up and running. Now it is possible for SW to
switch ON other needed regulators.

Modes of operation

Mode Description

NO_SUPPLY (dead) mode means that the main battery is not present or its voltage is too low (below
RETU master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over RETU master
reset threshold. All regulators are disabled, PurX is on low state, the RTC is on and the
oscillator is on. PWR_OFF (cold) mode is almost the same as PWR_OFF (warm), but the
RTC and the oscillator are off.

RESET RESET mode is a synonym for start-up sequence. In this mode certain regulators are
enabled and after they and RFClk have stabilized, the system reset (PurX) is released
and PWR_ON mode entered. RESET mode uses 32kHz clock to count the REST mode delay
(typically 16ms).
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Mode Description

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low. There are in principle three different sleep modes:

• Golden Eye sleep

• RAP3G sleep

• Golden Eye and RAP3G sleep (deep sleep)

In SLEEP mode RETU’s regulators VIO, VDRAM, VSIM1, VSIM2, VAUX and Vana are in low
quiescent current mode (output voltages still present but regulators will not give as
much current out). Other regulators including VR1 supplying system clock oscillator are
disabled.

In SLEEP mode, TAHVO VCORE SMPS regulator is in low quiescent current mode (if sleep
mode is not internally disabled). Linear regulator VOUT state depends on the accessory
connected to the system connector (Pop-Port), if there is any.

FLASHING FLASHING mode is for SW downloading.

Power distribution
The power distribution is shown in the diagram below. Current consumption is measured via the Current
Gauge Resistor and the battery voltage is stabilized by means of a capacitor. The tables below specifies the
voltages.

Figure 85 Power regulator diagram

Internal regulators
The table below shows the internal regulators. Also see the Power distribution diagram.
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Table 15 Internal regulators

Regulator Min voltage
[V]

Nom
voltage

[V]

Max
voltage [V]

Max load
current,
normal

[mA]

Max load
current*,

sleep
[mA]

Controll
ed by

Notes

In RETU:

VIO 1.72 1.82 1.92 250 2.0 HW

VSIM1 1.7 1.8 1.9 70 0.5 SW

2.8 3.0 3.2 30

VSIM2 1.7 1.8 1.9 70 0.5 SW Not used

2.8 3.0 3.2 30

Vaux 2.4 2.5 2.6 100 2.2 SW

2.7 2.78 2.86

Vana 2.42 2.5 2.58 80 1 HW

VDRAM 1.72 1.82 1.92 150 0.7 HW/SW **

2.4 2.5 2.6 150

VRCP1 4.6 4.75 4.9 5 *** - SW Supply to RF
part

VRCP2 4.6 4.75 4.9 5 *** - SW Supply to RF
part

VR1 2.42 2.5 2.58 15 - HW VCTCXO
regulator, RF

part

VRFC 1.73 1.8 1.87 15 - SW Supply to
RAP3G RF

converters

Vback 2.2 2.5 2.6 0.150 0.150 HW

In TAHVO:

VOUT 2.43 2.5 2.57 90 0.5 SW

VCORE 10.185 1.05 10.815 400 20 HW SMPS

12.125 1.25 12.875

13.095 1.35 13.905

13.580 1.40 14.420

VCCint 2.43 2.5 2.57 8 - SW In FBUS mode
In USB mode3.0 3.42 3.6

*) maximum allowable load current in sleep

**) VDRAM output can be fed from VANA or from VIO in sleep mode

***) Total current for charge pump is 6mA (if both regulators are ON at the same time).
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External regulators
The table below shows the external regulators. Also see the Power distribution diagram.

Table 16 External regulators

Regulator Min voltage
[V]

Nom
voltage [V]

Max
voltage [V]

Max load
current,
normal

[mA]

Max load
current,

sleep [mA]

Controlled
by

Notes

LED driver 16 31* 0 SW Disabled in
sleep.

LED driver
#2

8 63* 0 SW Disabled in
sleep.

VFLASHLIG
HT

18 80 0 SW Disabled in
sleep.

VCAM_2V8*
*

2.765 2.85 2.936 150 0 SW Disabled in
sleep.

VCAM_1V8*
*

1.728 1.8 1.872 150 0 SW Disabled in
sleep.

VCAM_1V5*
*

1.532 1.57 1.617 400 0 SW Disabled in
sleep.

2V8_FM_LC
D

2.765 2.85 2.936 150 150 HW Only
turned off
in power
off mode.

VMMC 2.75 2.85 2.95 150 0 SW Disabled in
sleep.

*) 500mW is max output

Clocking scheme
In BB5.0, two main clocks are provided to the system: 38.4MHz RF clock produced by VCTCXO in RF section
and 32.768kHz sleep clock produced by RETU with an external crystal.

RF clock is generated only when VCTCXO is powered on by RETU regulator. Regulator itself is activated by
SleepX signals from both RAP3G and Golden Eye. When both CPUs are on sleep, RF clock is stopped.

RF clock is used by RAP3G that then provides (divided) 19.2MHz SysClk further to Golden Eye. Both RAP3G and
Golden Eye have internal PLLs which then create clock signals for other peripheral devices/interfaces like RS
MMC, SIM, CCP, I2C and memories.

32k Sleep Clock is always powered on after startup. Sleep clock is used by RAP3G and OMAP for low-power
operation.

SMPS Clk is 2.4MHz clock line from RAP3G to TAHVO used for switch mode regulator synchronizing in active
mode. In deep sleep mode, when VCTCXO is off, this signal is set to '0'-state.

BT Clk is 38.4MHz signal from HINKU ASIC to BT module.

CLK600 is 600KHz signal from TAHVO to APE VCORE SMPS. The clock source is internal RC oscillator in TAHVO
(during the power-up sequence) or RAP3G SMPS Clk divided by 4 after the power-up sequence.
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Figure 86 Clocking scheme

 USB, SIM, MMC

USB
USB (Universal Serial Bus) provides a wired connectivity between a USB host PC and peripheral devices.

USB is a differential serial bus for USB devices. USB controller (RAP3G) supports USB specification revision 2.0
with full speed USB (12 Mbps). The device is connected to the USB host through the Pop-Port™ connector.
The USB bus is hot plugged capable, which means that USB devices may be plugged in/out at any time.

SIM interface
The device has one SIM (Subscriber Identification Module) interface. It is only accessible if battery is removed.
The SIM interface consists of an internal interface between RAP3G and Retu and of an external interface
between Retu and SIM contacts. The main SIM interface functionality is in RAP3G while Retu takes care of
power up/down, card detection, ATR (Answer To Reset) counting and level shifting. For Retu external SIM IF
connections, see SIM interface connections (page ).

The SIM IF is shown in the following figure:
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Figure 87 SIM interface

Retu handles the detection of the SIM card. The detection method is based in the BSI line. Because of the
location of the SIM card, removing the battery causes a quick power down of the SIM IF.

The Retu SIM1 interface supports both 1.8V and 3.0V SIM cards. The SIM interface voltage is first 1.8V when
the SIM card is inserted, and if the card does not response to the ATR a 3V interface voltage is used.

The data communication between the card and the phone is asynchronous half duplex, and the clock supplied
to the card is 1-5MHz, which is 3.2MHz by default (in GSM system). The data baud rate is the SIM card clock
frequency divided by 372 (by default), 64, 32 or 16.

 Cameras

Back camera
The back camera of the device uses a 2.0 megapixel camera module with a sensor resolution of 16000 x 1200.
The following block diagram shows how a CCP bus is used to transfer image data from the camera module
to the phone engine. This bi-directional control bus is a software-implemented I2C interface.

The camera regulator N1470 powers the digital parts of the camera, and a VAUX power rail is used for
powering the analogue parts.

A CAMVCTRL signal (Vctrl) is used for activating the camera module. When the Vctrl signal is High, the module
enters the power on mode. When the signal is Low, the module enters the power off mode.

A CAMCLK signal feeds the system clock for the camera module.
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Figure 88 Block diagram of the back camera module

Flash LED
The device back camera includes a flash LED (FLED) providing better lighting conditions in darker
environments. The same LED is also used as an indicator light for indicating when a video clip is being
recorded.

The FLED is located beside the back camera. It is only used when the back camera is in the still image mode
or as an indicator for video recording or image capturing. The operating range of FLED is approximately 1 m
(~22 Lux) and 1.5 m (~9 Lux).

The connections between the main PWB and the FLED is implemented with a small PWB attached to the
device mechanics.

The FLED has four white LEDs connected in series in one module. The module also includes a lens with its
plastic housing. The dimensions of the FLED are 6.5 x 7.5 x 3.5 mm.
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Figure 89 Simplified flash LED connection

Front camera
The front camera has VGA (640x480) resolution, and it is mainly used for video calls. It can also be used as a
still camera and camcorder.

The front camera is controlled and its data is collected by Golden Eye APE. The I/O voltage of Golden Eye is
1.8V and the I/O voltage of the camera is 2.8V. Because of this, a level shifter is used for the interface between
Golden Eye and the camera.

The front camera has the following characteristics:

Sensor type: CMOS

Sensor Photo detectors: 300k

F number/Aperture: f/2.8

Focal length: 2.13 mm

Focus range: 40 cm to infinity

Still Image resolutions: 640 x 480

Video resolutions: 176 x 144, 128 x 96 both 15 frames per second.

Video clip length: 30 seconds or free, maximal clip length in free mode is
1 hour

Video file format: 3GPP, *.3gp (64 kbps in short clip mode, 128 kbps in
maximum mode)

Exposure: Automatic

White Balance: Automatic

ISO: 250 - 2000 (Automatic)

Capture Modes: Night mode, Sequence mode, Selftimer
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Figure 90 Front camera connections

 User interface

Display interface

Display module mechanical concept

Figure 91 General diagram of the LCD module

Display features:

• 262 k colours

• Partial display function Power saving by pausing display process on part of the screen.

• Built-in RAM capacity 176rows×208lines×16bit = 585,728 bits

The display has two different operating modes:

1 Normal mode, Full screen, 262k colours

2 Normal Partial mode, 262k colours but only part of the display is active

The interconnection between the LCD module and the Nokia engine is implemented with a 24-pin board-to-
board connector.
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Display is controlled via MeSSi-8 interface by Golden Eye. All MeSSi-8 signals go through the EMC filtering ASIPs.

The display module does not require any tuning in service.

Top keyboard
The UI-Keys a placed on normal rigid FR4 board connected through the flex to the main PWB. All keys on the
top UI board have a dedicated line. All lines are routed through a 10 channel Key-ASIP Z3300.

The top keypad contains 2 backlight LEDs.

Figure 92 Top keyboard keys

Main keyboard
All keys on the main board are included in a 4x4 key scan matrix. All lines are routed through 10 channal Key-
ASIP Z2580.

The main keyboard contains 2 backlight LEDs.
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Figure 93 Main keyboard

 Audio concept

Audio HW architecture
The functional core of the audio hardware is built around two ASICs: RAP 3G CMT engine ASIC and the mixed-
signal ASIC Retu.

Retu provides an interface for the transducers and the accessory connector. Because audio amplifiers are
also integrated into Retu, the only discrete electronics components needed for audio paths are audio filtering
components and EMC/ESD components.

There are three audio transducers:

• 8mm dynamic earpiece

• 16mm dynamic speaker (IHF)

• electret microphone module

In addition to the audio transducers, Retu also provides an output for the dynamic vibra component.

All galvanic audio accessories are connected to the Pop-Port™ accessory connector.

A Bluetooth audio module that is connected to RAP3G supports Bluetooth audio functionality. There is a FM
stereo radio integrated with the Bluetooth ASIC.

There is a separate application ASIC, Golden Eye, for Symbian applications.
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Figure 94 Audio block diagram

Internal microphone
Internal microphone is used for HandPortable (HP) and Internal HandsFree (IHF) call modes.

An analogue electret microphone is connected to Retu ASIC’s Mic1P and Mic1N inputs via asymmetric electrical
connection.

The microphone is biased by Retu ASIC MicB1 bias voltage output.

Figure 95 Internal microphone circuitry

External microphone
Galvanic accessories are connected to the system connector (Pop-PortTM).

Accessory audio mode is automatically enabled/disabled during connection/disconnection of dedicated
phone accessories.
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External microphone circuitry is biased by Retu ASIC MicB2 bias voltage output. The circuitry provides a
symmetrical connection for the microphone from the Pop-PortTMconnections, XMICN and XMICP, to Retu ASIC
inputs, Mic2P and Mic2N.

Figure 96 External microphone circuitry (Pop-Port connects to the right side)

Internal earpiece
The internal earpiece is used in the HandPortable (HP) call mode. A dynamic 8 mm earpiece capsule is
connected to Retu ASIC’s differential outputs EarP and EarN.

Figure 97 Internal earpiece circuitry

Internal speaker
The internal speaker is used in Internal HandsFree (IHF) call mode.

A dynamic 16 mm speaker is connected to Retu ASIC’s outputs HFSpP and HFSpN.

The IHF amplifier integrated in Retu is a Digital Pulse Modulated Amplifier (DPMA).

Figure 98 Internal speaker circuitry
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External earpiece
All galvanic accessories are connected to the system connector (Pop-Port™).

The accessory audio mode is automatically enabled/disabled during connection/disconnection of dedicated
phone accessories.

Retu ASIC provides two output channels in either single-ended or differential format. Retu ASIC outputs XearL
and XearLC form the left channel audio output, and XearR and XearRC the right channel audio output. XearLC
and XearRC are the ground pins if the output works in a single-ended operation.

In the Pop-Port™ side, HSEAR P and HSEAR N form the left channel output, and HSEAR R P and HSEAR R N the
right channel output. Respectively, HSEAR N and HSEAR R N are the ground pins if the output works in a single-
ended operation.

Figure 99 External earpiece circuitry (Pop-Port connected on the right)

Vibra circuitry
Vibra is used for vibra-alarm function.

The vibra motor is connected to the Retu ASIC VibraP and VibraN Pulse Width Modulated (PWM) outputs.
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Figure 100 Vibra circuitry

Pop-portTM connector
Pop-PortTM connector provides a fully differential 4–wire stereo line-level output connection and fully
differential 2-wire mono line-level or microphone level input connection.

The handsfree driver in Retu is meant for the headset.

The output is driven in a fully differential mode. In the fully differential mode, the handsfree pin is the
negative output and the HFCM pin is the positive output. The gain of the handsfree driver in the differential
mode is 6 dB.

The earpiece and headset signals are multiplexed so that the outputs cannot be used simultaneously.

Figure 101 System connector pin layout

Table 17 Pop-PortTMpin and signal table

Pin #/ Signal
name

Signal
description

Spectral range Voltage/
Current levels

Max or nominal
serial
impedance

Notes

1/ Charge V Charge DC 0-9V/ 0.85A

2/ GND Charge GND - 0.85A 100mΩ (PWB+
conn.)

3/ ACI ACI 1kbits/s Digital 0 / 47Ω Insertion &
removal
detection

2.5-2.78V

4/ Vout DC out DC 2.78V 70 mA 100mΩ (PWB+
conn.)

200mW

2.5V 90mA

5/USB Vbus USB power 4.375-5.25VDC 115.2kbit
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Pin #/ Signal
name

Signal
description

Spectral range Voltage/
Current levels

Max or nominal
serial
impedance

Notes

6/Fbus_RX/USB
D+

Data
connection

115.2kbit

7/Fbus_TX/USB
D+

Data
connection

115.2kbit

8/Data GND USB Ground 115.2kbit

9 / XMIC N Audio in 300-8k 1Vpp &

2.5-2.78VDC

10 / XMIC P Audio in 300-8k 1Vpp &

2.5-2.78VDC

11 / XEAR N Audio out 20-20k 1Vpp 10Ω

12 / XEAR P Audio out 20-20k 1Vpp 10Ω

13 / XEAR R N Audio out 20-20k 1Vpp 10Ω Not conn. in
mono

14 / XEAR R P Audio out 20-20k 1Vpp 10Ω Not conn. in
mono

 Bluetooth and FM radio

Bluetooth
Bluetooth provides a fully digital link for communication between a master unit (the phone) and one or more
slave units (e.g. a wireless headset). The system provides a radio link that offers a high degree of flexibility
to support various applications and product scenarios. Data and control interface for a low power RF module
is provided by the module.

The Bluetooth is physically integrated with the FM radio into one single module. From a functional point of
view they, however, have nothing in common.
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Figure 102 Bluetooth interface

The Bluetooth has a separate built in antenna and is powered by VBAT and the regulated voltage VIO. For
audio applications the Bluetooth has a PCM data bus. In addition a UART (universal asynchronous receiver/
transmitter) is used for data communication and controls.

FM radio
The FM radio is physically integrated with the Bluetooth into one single module. From a functional point of
view they, however, have nothing in common (for information on Bluetooth, see page (page 9–22)).

Figure 103 FM interface

The FM radio is an integrated circuit, controlled by MCU software through a serial bus interface. The wires of
the headset are used as poles of the antenna, and no other antenna is needed for FM radio reception.
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In addition to the Bluetooth unit the FM radio is provided with LDO (low drop out) voltage 2V8_FM_LCD.

The radio has an automatic band search function, which can search for a strong write/read signal from a
certain frequency. When this is found, data is transmitted to the radio. When the signal strength is low, the
RETU can read data, which is available until the signal is strong again.

 RF description

Introduction to receiver functionality
Receiver functions are implemented in an RF ASIC.

The receiver is a linear direct conversion receiver consisting of separate front ends (LNA (Low Noise Amplifier)
and demodulator) for each supported system. After the demodulators, the signal paths are combined to one
common BB path.

WCDMA receiver
In the WCDMA mode, the received signal is fed from the antenna to the duplex filter. After the duplex filter
the signal goes via balun to the integrated LNA (Low Noise Amplifier) residing in N7500. After the LNA, the
signal goes trough an off chip band pass SAW filter. The main task of the filter is to attenuate the Tx signal
which amplified by LNA and is leaking trough the duplex filter.

After filtering, the signal goes to the down conversion mixer, which converts the signal to baseband I and Q
signals (90 degrees phase shift). After the demodulator output, there is an RC low pass filter with f0 of ca.
1.5 MHz.

At BB frequency the signal is amplified and fed to a low pass filter.

The Rx channel filter must be calibrated with an automatic routine whenever N7500 IC is changed to a phone.

In the WCDMA mode, the corner frequency of the filter is set to ca. 2.1MHz. The filter is followed by an AGC
(Automatic Gain Control) amplifier with an adjustable gain. The signal is further amplified before it is fed to
balanced analogue IQ output pins. The analogue output pins are accompanied by reference voltage output,
which sets the DC level for the AD converter in BB ASIC RAP3G.

The last stage of the RF Rx chain is an output buffer which feeds the signal and a reference voltage (VREFCM)
to the BB ASIC. The AGC stages are used to maintain the voltage swing at the input of the AD converters at
an adequate level.

GSM receiver
As GSM900, GSM1800 and GSM1900 Rx branches are functionally identical, the following description is
applicable to all of them.

The received signal goes from the GSM antenna to the antenna switch module. The antenna switch module
contains PIN diode switches for a band and Rx/Tx selection and also Rx SAW filters.

The antenna switch module is followed by integrated LNAs residing in N7500.

The LNAs are followed by demodulators which downconvert the signal to baseband I and Q signals.

After the down conversion mixer, the Rx chain is similar to the WCDMA Rx. The channel select filter is set to
115 kHz in the GSM mode.

Introduction to transmitter functionality
Transmitter functions are implemented in an RF ASIC. The ASIC contains a BB frequency low pass filter, which
is tunable according to the signal bandwidth of the system in use.

In addition, the ASIC contains separate RF paths comprising a final frequency IQ modulator and VGA amplifiers.
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WCDMA transmitter functionality
In the transmitter side, an analogue I/Q modulated signal is received from digital baseband into an RF ASIC
and feed through a low pass filter. The corner frequency of the filter is set to approximately 3 MHz. After the
filter the signal is feed to the IQ modulator, which converts the signal to final Tx frequency. There are two
separate I/Q modulators: one for WCDMA and another for GSM signals. The modulator is followed by two VGA
stages giving 85 dB of gain control range. The signal then exits the RF ASIC via a balanced line. Next, the
signal is band pass filtered by a SAW filter before it is fed to the WCDMA PA module. After the PA, the
transmitted WCDMA signal is fed through an isolator and a duplex filter to the antenna.

Figure 104 WCDMA transmitter

WCDMA power control
WCDMA Tx power control is accomplished by the two VGA amplifier stages in the Tx ASIC.

The VGAs have a common temperature compensation circuit and one voltage mode analogue input for gain
control (TXC).

The gain of the VGA amplifier chain is controlled by a DA converter in BB. The same DA converter is shared by
GSM Tx power control function.

A sample of the output power is taken by a capacitor between the power amplifier and the isolator, and fed
to a diode power detector. The output of the detector is low pass filtered, and the voltage is then AD converted
in BB.

Another function of the detector voltage is to steer the DC/DC converter, which is providing a variable supply
voltage for the WCDMA PA.

WCDMA PA module
The WCDMA PA is housed in a separate module having:

• a variable supply voltage input for the amplifier stages (Vcc11),
• a battery supply voltage for the bias circuits (Vcc12),
• and two bias current inputs.

Bias currents are generated by 5-bit DA converters in the RF ASIC. The converters are controlled by BB via
RFBus.

If a different manufacturer's PA is changed to the phone, this setting must be set again.
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The bias currents are also used as PA on/off controls. The structure of the WCDMA PA is shown in the following
figure. The supply voltage for the output stage is got from a DC/DC converter in order to improve the efficiency
at low power levels.

PA DC/DC converter
The control of the DC/DC converter is fed back from the power detector circuit.

The DC/DC converter limits the lowest supply voltage to 1.5 V. At highest power levels the DC/DC converter
output settles nominally to 3.2 V.

Figure 105 Block diagram of DC/DC converter and WCDMA PA

GSM transmitter functionality
An RF ASIC receives an analogue IQ modulated signal from digital BB, which is first low pass filtered with
filter corner frequency set to approximately 200 kHz. After the filter, the signal is routed to the GSM modulator.
The amplifier gives 40 dB of power control dynamic range.

After the VGA stage the signal exits the RF ASIC. In case of GSM1800/1900 the signal goes directly to the GSM
PA module. In case of EGSM900 (and GSM850), the PA module is preceded by a SAW filter. After the filter, the
signal is fed to the GSM PA module. Finally, the signal is routed via the antenna switch to the antenna.
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Figure 106 GSM transmitter

GSM power control
A closed control loop comprise an integrated power detector (in PA module) and an error amplifier. The error
amplifier resides in N7501, and it controls the transmitter power of GSM.

Detector output from the PA gives a DC level proportional to the output power. The DC voltage is fed to the
negative input of the error amplifier, where it is compared to the level of the reference signal, TXC. TXC is got
from the BB circuitry. The output of the error amplifier is fed to a buffer amplifier, which in turn steers the
VGA amplifier.

The power control loop is enabled and disabled by writing an appropriate register in N7501 RF ASIC. In case
of dual slot transmission, the output power is ramped down between the consecutive slots.

GSM PA module
A single GSM/EDGE PA module contains two separate amplifier chains, one for EGSM900 (and GSM850) and
another for GSM1800/1900. Both amplifiers have a battery supply connection and two bias current inputs.

Frequency synthesizers
RF has separate synthesizers for Rx and Tx. Both synthesizers consist of:

• PLL (Phase-Locked Loop)
• loop filter
• VCO (Voltage Controlled Oscillator)
• balun

The VCO frequencies are locked by PLLs into a reference oscillator, VCTCXO (Voltage Controlled Temperature
Compensated Crystal Oscillator).

The PLLs are located in RF ASICs and controlled via RFBus.

The VCOs operate at the channel frequency multiplied by two in the upper bands and by four in EGSM900
(and GSM850, if applicable). The required frequency dividers required for modulators and demodulators are
integrated into RF ASICs. The dividers are controlled via RFBus.
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Reference oscillators
A 38.4MHz VCTCXO is used as a reference oscillator for the frequency synthesizers.

The output signal of the VCTCXO is directly connected to both RF ASICs where it is used as synthesizer reference.
The other RF ASIC also contains a balanced buffered output for supplying the clock signal to the digital BB
ASIC and a single ended buffer for Bluetooth.

The frequency of the reference oscillator is locked into the frequency of the base station with the help of an
AFC (Automatic Frequency Control) voltage, which is generated in BB by a DSP (Digital Signal Processor) and
converted by a dedicated DAC (Digital-to-Analogue-Converter).

Regulators
RF ASICs contain integrated regulators to supply regulated voltages for their internal circuitry and other RF
parts. Rx VCO supply is got via a switch from an RF ASIC VR1 regulator. VCO can be switched on and off by
controlling the switch via RFBus.

Supply voltage for the VCTCXO is provided by a BB mixed mode ASIC. The same supply is used for reference
clock input buffers, output buffers and for the digital control blocks of both RF ASICs.

Other supplies, like 4.7 V supply for PLL charge pumps and bias reference (VREFRF01) are also provided by
the BB mixed mode ASIC.

Figure 107 RF supply connections from the BB mixed mode ASIC
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 Schematics

System connector

Figure 108 RM-78, 1mda_05a: System connector
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Retu

Figure 109 RM-78, 1mda_05a: Retu
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Tahvo

Figure 110 RM-78, 1mda_05a: Tahvo
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RAP3G, memories, mini SD card

Figure 111 RM-78, 1mda_05a: RAP3G, memories, mini SD card
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Camera, B&B connectors, keyboard

Figure 112 RM-78, 1mda_05a: Camera, B&B connectors, keyboard

RM-78
Schematics Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 10 –8
Copyright © 2005 Nokia. All rights reserved.

 



FM & BT module

Figure 113 RM-78, 1mda_05a: FM & BT module

RM-78
Schematics Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 10 –9
Copyright © 2005 Nokia. All rights reserved.

 



RF-part

Figure 114 RM-78, 1mda_05a: RF-part
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Signal overview

Figure 115 RM-78, 1mda_05a: Signal overview
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Component finder

Figure 116 RM-78, 1mda_05a: Component finder
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A/D-converter Analog-to-digital converter

ACI Accessory Control Interface

ADC Analog-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic ,type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2,UEME and Zocus

CCP Compact Camera Port

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSR cambridge silicon radio

CSTN Color Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analouge converter

DAC Digital-to-analouge converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo

DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package
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DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evaluation

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compability

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity

IR Infrared

IrDA Infrared Data Associasion

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode
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LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architechture

OMAP Operations, maintenance, and administartion part

Opamp Operational Amplifier

PA Power amplifier

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board

PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RF Radio Frequency

RF PopPort TM Reduced function PopPortTM interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multi Media Card

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver
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SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noice ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP, Official Tiku3G

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC

USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WD Watchdog

XHTML Extensible hypertext markup language

Zocus Current sensor, (used to monitor the current flow to and from the battery)
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